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C H A P T E R  1  

Introducing AFT Impulse 

Welcome to AFT Impulse™ 7, Applied Flow Technology's powerful 
waterhammer modeling tool. With AFT Impulse you can model 
transients caused by a wide range of pipe system behavior. This will 
allow you to understand transient pressure extremes and, when 
necessary, size and locate surge suppression equipment. 

AFT Impulse includes a steady-state solution engine which solves for the 
system initial conditions. These results are used to automatically 
initialize the transient model. The engineer accesses these capabilities 
through an advanced graphical interface, which includes built-in 
expertise to guide the engineer through the modeling process. 

AFT Impulse 7 has two available add-on modules which extend AFT 
Impulse’s extensive modeling capabilities into new areas.  

 The Settling Slurry (SSL) module allows the engineer to perform 
the complex property and system interaction calculations 
associated with settling slurry flows. 

 The PFA Pulsation Frequency Analysis (PFA) module allows the 
engineer to determine resonant frequencies that can result in 
excessive vibration and damage to systems. 

Designing for waterhammer 

Waterhammer can cause catastrophic failure of pipe systems and damage 
expensive equipment. Properly addressing such issues at the design stage 
is essential. An AFT Impulse model allows the engineer to better 
understand and predict the dynamic behavior of the pipe system. When 
undesirable waterhammer transients are identified at the design stage 
different strategies to reduce surge pressures can be evaluated. These 
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may include surge suppression equipment, modifying the design, or 
modifying the system operation. 

Sometimes the undesirable transients are not discovered until after the 
system is built. In such cases, AFT Impulse can provide critical insight 
into the cause of the problem and allow the engineer to assess design 
and/or operational modifications to resolve the issue. 

Modeling capabilities 

AFT Impulse provides a broad array of features to model pipe system 
transients. These include: 

 Transients in open and closed (recirculating) systems 

 Network systems that branch or loop 

 Systems with valve transients 

 Systems with pump transients 

 Systems with pressure or flow control valve transients 

 Systems with transient cavitation and liquid column separation 

 Systems with surge suppression devices such as accumulators, surge 
tanks and vacuum breaker valves 

 Systems with variable density and viscosity 

 Multiple design cases in a single model file 

 Non-Newtonian fluid behavior 

Add-on module capabilities (optional) 

 System performance for settling slurry calculations (SSL module) 

 Identification of resonant frequencies (PFA module) 

 Positive displacement pump speeds which excite resonant 
frequencies (PFA module) 

The steady-state solver 

Before a waterhammer model can be run, the initial steady-state 
conditions are required. AFT Impulse obtains the steady-state solution 
using a Newton-Raphson matrix solution algorithm to obtain a mass and 
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momentum balance. The algorithm is similar to that used in the 
acclaimed AFT Fathom™.  

If desired, AFT Impulse can be run in “Steady Only” mode where only 
the steady flow pipe hydraulics are modeled. When run in “Transient” 
mode, the steady flow solution is used to automatically initialize the 
transient solution. This convenience helps the user avoid the often  
error-prone process of manually setting up the initial conditions, and it 
allows the user to quickly and safely modify and rerun the model. 

The transient solver 

AFT Impulse employs the traditional Method of Characteristics (MOC) 
to solve the transient equations of pipe flow. A mass and momentum 
balance is performed at all computing stations in each pipe, accurately 
representing the propagation of transient pressure waves throughout the 
system. 

The MOC is an explicit solution technique, where the Solver marches in 
time for a duration specified by the user. 

Thermophysical property data 

AFT Impulse derives physical properties from one of five sources. The 
first is the standard AFT Impulse set of incompressible fluids which 
contains data for about 10 common fluids (called AFT Standard).  

The second is User Specified Fluid, for which data is provided by the 
user. The third is water (and steam) data from the ASME Steam tables. 

The fourth is the NIST REFPROP database, first introduced in AFT 
Impulse 7. REFPROP is licensed from the National Institute of Standards 
and Technology and is included in AFT Impulse. REFPROP has a 
database of approximately 150 fluids and supports user specified fluid 
mixtures. AFT Impulse is restricted to non-reacting mixture calculations. 

The fifth is the Chempak™ database. Chempak is licensed from Madison 
Technical Software and is offered as an optional add-on to AFT Impulse. 
Chempak has a database of approximately 700 fluids and supports user 
specified fluid mixtures. AFT Impulse is restricted to non-reacting 
mixture calculations. 
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Engineering assumptions in AFT Impulse 

AFT Impulse is based on the following fundamental fluid mechanics 
assumptions: 

 Liquid flow 

 One-dimensional flow 

 No chemical reactions 

 Wavespeed remains constant during transients 

 Non-condensable gas release is negligible 

 Bubbles that form during transient cavitation do not move 

AFT Impulse Primary Windows 

The AFT Impulse window has five subordinate windows that work in an 
integrated fashion. Each is located on a separate, movable tab. You work 
exclusively from one of these windows at all times. For this reason, they 
are referred to as Primary Windows. 

Of the five Primary Windows, two are input windows, two are output 
windows, and one displays both input and output information. Figure 1.1 
shows the relationship between the Primary Windows.  

 

 

Figure 1.1 Primary Window workflow in AFT Impulse 

Input windows 

The two windows that function exclusively as input windows are the 
Workspace window and the Model Data window. These two windows, 
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one graphical and the other text-based, work together to process model 
input data with immense flexibility. The tools provided in these two 
windows allow you to model a large variety of pipe networks. 

The Visual Report window can function in support of both input and 
output data. As an input window, it allows you to see the input data 
superimposed on the pipe system schematic created on the Workspace. 

Output windows 

The two windows that function exclusively as output windows are the 
Output window and the Graph Results window. The Output window is 
text-based, while the Graph Results window is graphical. These two 
windows offer a powerful and diverse range of features for reviewing 
analysis results for modeling errors, gaining a deeper understanding of 
the pipe system's flow behavior, and preparing the results for 
documentation.  

As an output window, Visual Report allows you to see the output results 
superimposed on the pipe system schematic created on the Workspace. 

The five Primary Windows form a tightly integrated, highly efficient 
system for entering, processing, analyzing, and documenting transient 
incompressible flow analyses of pipe networks. 

Note: AFT Impulse will support dual monitors.  You can click and drag 
any of the five Primary Window tabs off of the main AFT Impulse 
window.  Once you drag one of the Primary Windows off of the Impulse 
window, you can move it anywhere you like on your screen, including 
onto a second monitor in a dual monitor configuration.  To add the 
Primary Window back to the main AFT Impulse primary tab window 
bar, simply click the X button in the upper right of the Primary Window. 
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Valve Closure Example 

Summary 

This chapter is designed to give you the big picture of AFT Impulse's 
layout and structure. Some of the more basic concepts will be used to 
build a four-pipe, five-junction model of the waterhammer transients that 
result when a valve is closed. 

A number of other example model discussions are included in a Help file 
distributed with AFT Impulse called ImpulseExamplesMetric.chm. It can 
be opened from the Help menu by choosing "Show Examples" and 
selecting “Metric Units…”. 

Topics covered 

 Model building basics 

 Entering pipe and junction data 

 Specifying System Properties 

 Entering transient data 

 Sectioning pipes 

 Graphing output results 

Required knowledge 

No prior knowledge is required for this example. 
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Model file 

This example uses the following file, which is installed in the Examples 
folder as part of the AFT Impulse installation: 

 Valve Closure Metric.imp 

This example is also provided in US customary units under the English 
Units file name, Valve Closure.imp. 

This example will require you to build the model from scratch to help 
familiarize yourself with the steps required to build a complete model in 
AFT Impulse. Therefore, use this example model file as a reference only. 

Problem Statement 

For this problem, water flows from two separate supply tanks and 
combines into a single 12 inch line before flowing to a downstream 
reservoir. The flow is controlled by opening and closing a valve in the 12 
inch line.  

This model will simulate the closure of the valve over a period of 1 
second. The valve will stay closed for the remaining simulation duration. 

Graph the pressure at the inlet of the valve over the entire simulation 
duration to determine the maximum pressure that occurs at the valve 
during the transient.  

Step 1. Start AFT Impulse 

 To start AFT Impulse, click Start on the Windows taskbar, choose All 
Programs, then AFT Products, and then AFT Impulse. (This refers to the 
standard menu items created by setup. You may have chosen to specify a 
different menu item).  

As AFT Impulse is started, the AFT Impulse Startup window appears, as 
shown in Figure 2.1. This window provides you with several options you 
can choose before you start building a model.  
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Figure 2.1 AFT Impulse startup window 

Some of the actions available from the AFT Impulse Startup window are: 

 Open a previous model, browse to a model, or browse to an Example 

 Activate an Add-on Module 

 Select “ASME Water” or a recently used fluid to be the Working 
Fluid 

 Review or modify Modeling Preferences 

 Select a Unit System 

 Filter units to include Common Only or Common Plus Selected 
Industries 

 Choose a Grid Style 

 Select a Default Pipe Material 
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 Access other Resources, such as Quick Start Guides, Help Files, and 
Video Tutorials 

If this is the first time that you have started AFT Impulse, Modeling 
Preferences will be expanded in the middle section of the Startup 
Window, as shown in Figure 2.2. If this is not the first time that you have 
started AFT Impulse, the Startup Window will appear with Modeling 
Preferences collapsed, as shown in Figure 2.1. 

When collapsed, you can view your current Modeling Preferences at the 
bottom of Start a New Model. To further review or adjust your 
preferences, click the “Modify>>” button (see Figure 2.1).  

 

Figure 2.2  Startup Window with Modeling Preferences Expanded 

With Modeling Preferences expanded, as in Figure 2.2, select “Both with 
US Defaults” under Unit System. Select “Common Only” under Filter to 
show only commonly used units, instead of “All Units.”  
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You can “Show Sample Units” to see which units will be included based 
on your selections, as shown in Figure 2.3. 

 

Figure 2.3  Show Sample Units with “Common Only” Selected 

The other Filter option is “Common Plus Selected Industries,” which will 
add units from the industries that you select. Once you have finished 
modifying your Modeling Preferences, click “Remember My Preferences 
and Hide.” Now that your unit preferences are set, click “Start Building 
Model.” 

Hide Sample 
Units
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The Workspace window is the initial active (large) window, as seen in 
Figure 2.2. The five tabs in the AFT Impulse window represent the five 
Primary Windows. Each Primary Window contains its own toolbar that 
is displayed directly beneath the Primary Window tabs. 

The Workspace window 

The Workspace window is the primary vehicle for building your model. 
This window has three main areas: the Toolbox, the Quick Access Panel, 
and the Workspace itself. The Toolbox is the bundle of tools on the far 
left. The Quick Access Panel is displayed on the far right. It gives easy 
access to a variety of features such as the Scenario Manager, the 
Checklist Panel, and viewing pipe and junction properties. The 
Workspace takes up the rest of the window.  

 

 

Figure 2.4 The Workspace window is where the model is built. The 
other four Primary Windows are found on the tabs 
along the top of the Workspace. The Status Bar shows 
the model status 

Primary Window Tabs 

Float Toolbar 

Toolbox 

Status Bar 
Workspace 
Zoom Tools

Workspace 

Workspace 
Overview Map 

Checklist Panel

Scenario Manager in 
Quick Access Panel

Quick Access Panel Pin 

Quick Access Panel 
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You will build your waterhammer model on the Workspace using the 
Toolbox tools. At the top of the Toolbox is the Float Toolbar. From here, 
you can choose the location of the Toolbox in reference to the 
Workspace by specifying Dock Left, Float, or Dock Right. Below the 
Float Toolbar are two drawing tools. The Pipe Drawing tool, on the 
upper left, is used to draw new pipes on the Workspace. Next to this tool 
is the Annotation tool. The Annotation tool allows you to create 
annotations and auxiliary graphics. 

Below the two drawing tools are twenty-one icons that represent the 
different types of junctions available in AFT Impulse. Junctions are 
components that connect pipes and also influence the pressure or flow 
behavior of the pipe system. The junction icons can be dragged from the 
Toolbox and dropped onto the Workspace. 

When you pass your mouse pointer over any of the Toolbox tools, a 
tooltip identifies the tool's function. 

Unpinning the Quick Access Panel 

By default, the Quick Access Panel is pinned to the Workspace window 
so that it is constantly displayed. The Quick Access Panel can be 
unpinned so it is only displayed when the mouse is moved over the tab 
displayed on the right edge of the Workspace window. Unpin the Quick 
Access Panel by clicking on the picture of the pin displayed in the top 
right corner of the Quick Access Panel (Figure 2.4). The Quick Access 
Panel will be unpinned for the remainder of the examples in this guide. 

Step 2. Lay out the model 

To lay out the valve closure model, you will place five junctions on the 
Workspace. Then you will connect the junctions with pipes. 

A. Place a reservoir 

 To start, drag a reservoir junction from the Toolbox and drop it on 
the Workspace. Figure 2.3a shows the Workspace with one reservoir. 

Objects and ID numbers 

Items placed on the Workspace are called objects. All objects are derived 
directly or indirectly from the Toolbox. AFT Impulse uses three types of 
objects: pipes, junctions and annotations. 
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All pipe and junction objects on the Workspace have an associated ID 
number. For junctions, this number is, by default, placed directly above 
the junction and prefixed with the letter “J”. Pipe ID numbers are 
prefixed with the letter “P”. You can optionally choose to display either 
or both the ID number and the name of a pipe or junction. You also can 
drag the ID number/name text to a different location to improve 
visibility. 

The reservoir you have created on the Workspace will take on the default 
ID number of 1. You can change this to any desired number greater than 
zero but less than 100,000. 

Editing on the Workspace 

Once on the Workspace, junction objects can be moved to new locations 
and edited using the features on the Edit menu. Cutting, copying, and 
pasting are all supported. A single level of undo is available for all 
editing operations. 

 

Figure 2.3a Valve closure model with first junction placed 
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B. Place the other junctions 

If a new junction type you want to add already exists on the Workspace, 
you have the option of duplicating that junction. You do this by choosing 
Duplicate from the Edit menu. Either duplicate the first reservoir, or drag 
a new reservoir junction onto the Workspace. Place the new reservoir 
somewhere to the right of the first reservoir junction (Figure 2.5b).  

Note: The relative location of objects in AFT Impulse is not important. 
Distances and heights are defined through dialog boxes. The relative 
locations on the Workspace establish the connectivity of the objects, but 
have no bearing on the actual length or elevation relationships. The 
Isometric Pipe Drawing Mode (see Chapter 5) can be used to visually 
represent the three-dimensional nature of a system. 

Place a branch, valve and third reservoir junctions from the Toolbox and 
drop them on the Workspace so that your model appears similar to that 
shown in Figure 2.5b.  

If the icons do not line up exactly, the calculations will not be affected. 
However, your model may have a nicer appearance if the icons line up. 
You can align the icons by using the align features selected from the 
Arrange menu. 

 

Figure 2.5b Valve closure model with all junctions placed 
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Before continuing, save the work you have done so far. Choose “Save 
As” from the File menu and enter a file name (Valve Closure perhaps) 
and AFT Impulse will append the “.imp” extension to the file name. 

C. Draw a pipe between J1 and J3 

Now that you have five junctions, you need to connect them with pipes. 

 To create a pipe, click the Pipe Drawing Tool icon on the Toolbox. The 
pointer will change to a crosshair when you move it over the Workspace. 
Draw a pipe below the junctions, similar to that shown in Figure 2.5c. 

The pipe object on the Workspace has an ID number (P1) that is shown 
near the center of the pipe.  

 

Figure 2.5c Valve closure model with first pipe drawn 

 To place the pipe between J1 and J3, use the mouse to grab the pipe in 
the center, drag it so that its left endpoint falls within the J1 Reservoir 
icon, then drop it there (see Figure 2.5d). Next, grab the right endpoint of 
the pipe and stretch the pipe, dragging it until the endpoint terminates 
within the J3 Branch icon (see Figure 2.5e). 
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Figure 2.5d Valve closure model with first pipe partially connected 

 

Figure 2.5e Valve closure model with first pipe connected 
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D. Add the remaining pipes 

A faster way to add a pipe is to draw it directly between the desired 
junctions. 

 Activate the Pipe Drawing Tool again, position the mouse pointer on 
the J2 Reservoir, then press and hold the left mouse button. Stretch the 
pipe across to the J3 Branch, and then release the mouse button. 
Continue drawing pipes P3 and P4 as indicated in Figure 2.5f. After all 
the pipes are drawn, all the objects in the model are graphically 
connected. Save the model by selecting Save in the File menu or by 
clicking on the diskette button on the Main Toolbar. 

 

Figure 2.5f Valve closure model with all pipes and junctions 
placed 

Reference positive flow direction 

There is an arrow on each pipe that indicates the reference positive flow 
direction for the pipe. AFT Impulse assigns a flow direction 
corresponding to the direction in which the pipe is drawn. 

You can reverse the reference positive flow direction by choosing 
“Reverse Direction” from the Arrange menu or selecting the Reverse 
Pipe Direction button on the Workspace Toolbar. 
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In general, the reference positive flow direction is used for reference 
purposes only and need not be the actual flow direction. However, when 
used with pumps and certain other junction types the pipes must be in the 
correct flow direction because that is how AFT Impulse determines 
which side is suction and which is discharge. If the reference positive 
flow direction is the opposite of that obtained by the Solver, the output 
will show the flow rate as a negative number.  

Note: Some users find it desirable to lock objects to the Workspace once 
they have been placed. This prevents accidental movement and 
disruption of the connections. You can lock all the objects by choosing 
Select All from the Edit menu, then selecting Lock Object from the 
Arrange menu. The lock button on the Workspace Toolbar will appear 
depressed, indicating it is in an enabled state, and will remain so as long 
as any selected object is locked. Alternatively, you can use the grid 
feature and snap to grid, which is turned on by default when you first 
start AFT Impulse. The grid options can be modified through the User 
Options window from the Tools menu.  

Step 3. Complete the first three checklist requirements 

 Next, click the checkmark on the Main Toolbar at the top of the AFT 
Impulse window. This opens the Checklist window (Figure 2.6). The 
Checklist window (also simply called the Checklist) contains five items. 
Each item needs to be completed before AFT Impulse allows you to run 
the Solver. 

Note: The Checklist contains five items, but if you are running your 
model in steady state mode only, the two items at the bottom of the list, 
Section Pipes and Specify Transient Control, will appear faded and you 
will be unable to open them because they pertain to the transient analysis 
only. To change back and forth between the steady state and transient 
analyses, choose either “Steady Only” or “Transient” from the Time 
Simulation selection on the Analysis menu. 

The state of each Checklist item can also be seen by clicking the Model 
Status light on the Status Bar at the bottom right corner of the AFT 
Impulse window (Figure 2.4). This will cause the Checklist to be 
displayed in the Quick Access Panel window to the right of the 
Workspace. The Checklist can also be shown from the View menu. Once 
the Checklist is complete, the Model Status light in the lower right corner 
turns from red to green. 
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Figure 2.6 The Checklist window tracks the defined and undefined 
model input 

A. Specify steady solution control 

The first item, “Specify Steady Solution Control”, is always checked 
when you start AFT Impulse because AFT Impulse assigns default 
solution control parameters for the steady-state part of the analysis. In 
general, you do not need to adjust these values. If necessary, you can 
make adjustments by opening the Steady Solution Control window from 
the Analysis menu. 

B. Specify system properties 

The second item on the Checklist is “Specify System Properties”. To 
complete this item, you must open the System Properties window. This 
window allows you to select your fluid as well as the viscosity model, 
gravitational acceleration and atmospheric pressure. 

You can directly enter fluid data (using User Specified Fluid), select a 
fluid from the standard AFT Impulse fluid database (AFT Standard), or 
select Water Data from ASME Steam Tables. Additionally, you can 
select from fluids and/or create mixtures using the NIST REFPROP 
database (included in AFT Impulse) or the Chempak database (an 
optional add-on to AFT Impulse). Users can also add their own custom 
fluids to the AFT Standard database. 

 Select System Properties from the Analysis menu to open the System 
Properties window (Figure 2.7). For this example, use the AFT Standard 
database and select “Water at 1 atm” in the upper list, then click the 
“Add to Model” button. Enter a temperature of 70 deg. F and click the 
Calculate Properties button to obtain the Density, Dynamic Viscosity, 
Bulk Modulus and Vapor Pressure. 
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Figure 2.7 System Properties window is where you specify the 
fluid 

 Open the Checklist by clicking the status light on the Status Bar and 
you should now see the second item checked off. 

Step 4. Define the model components (checklist item #3) 

The third item on the Checklist, “Define All Pipes and Junctions”, is not 
as straightforward to satisfy as the first two. This item encompasses the 
proper input data and connectivity for all pipes and junctions. 

Object status 

Every pipe and junction has an object status. The object status tells you 
whether the object is defined according to AFT Impulse’s requirements. 
To see the status of the objects in your model, click the light bulb icon on 
the Workspace Toolbar (alternatively, you could choose “Show Object 
Status” from the View menu). Each time you click the light bulb, “Show 
Object Status” is toggled on or off. 
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When “Show Object Status” is on, the ID numbers for all undefined 
pipes and junctions are displayed in red on the Workspace. Objects that 
are completely defined have their ID numbers displayed in black. (These 
colors are configurable through User Options from the Tools menu). 

Because you have not yet defined the pipes and junctions in this example 
problem, all the objects' ID numbers will change to red when you turn on 
“Show Object Status”. 

Showing undefined objects 

Another useful feature is the List Undefined Objects list (Figure 2.8). 
This can be opened from the View menu by clicking on “List Undefined 
Objects”, or by clicking on “Define All Pipes and Junctions” on the 
Checklist. Here all objects with incomplete information are listed. 
Clicking on an undefined pipe or junction will display the property data 
that is missing. Click the close button to stop showing this window. 

 

Figure 2.8 The Undefined Objects list lets you see the undefined 
properties for each undefined object 
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A. Enter data for reservoirs 

As shown in Figure 2.5f, the J1 junction is a Reservoir junction.  

 To define the first reservoir, open the J1 Reservoir Properties window 
(Figure 2.9) by double-clicking on the J1 icon. The pipe depth should 
now be enabled for entry, showing that Pipe 1 is connected to the 
reservoir. 

Note: You can also open an object's Properties window by selecting the 
object (clicking on it) and then either pressing the Enter key, double-
clicking the object, or clicking the Open Pipe/Junction Window icon on 
the Workspace Toolbar. 

 Enter the following properties into the J1 Reservoir Properties 
window: 

1. Set the Tank Model to “Infinite Reservoir”. 

2. Enter 15 meters for the Liquid Surface Elevation. You can assign 
any unit of pressure or elevation found in the adjacent drop-down 
menu of units 

3. Enter 0 barG (0 kPa(g)) for the Liquid Surface Pressure  

4. Enter 3 meters for the Pipe Depth (ensure that the radio button next 
to Pipe Depth is selected) 

Note: You can choose default units for many parameters (such as meters 
for length) in the User Options window in the Tools menu under 
Preferred Units. 

You can give the object a name, if desired, by entering it in the Name 
field at the top of the window. By default, the junction’s name indicates 
the junction type. In Figure 2.9, the name of this reservoir has been 
changed to Supply Tank A.  The name can be displayed on the 
Workspace, Visual Report or in the Output. 

Most junction types can be entered into a custom database allowing the 
junction to be used multiple times or shared between users. To select a 
junction from the custom database, choose the desired junction from the 
Database List in the junction’s Properties window. The current junction 
will get the properties from the database component. 
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Figure 2.9 Properties window for Reservoir J1 

The “Copy Data From Jct” list will show all the junctions of the same 
type in the model. This will copy the user selected parameters from an 
existing junction in the model to the current junction. 

Using the folder tabs in the Properties windows 

The information in the Properties windows is grouped into several 
categories (or folders) and placed on separate folder tabs. Click the folder 
tab to bring its information forward. Figure 2.9 is an example of a 
Reservoir’s Properties window. 

If there is only one pipe connected to the reservoir, the depth can be 
entered directly on the diagram on the Reservoir Model tab for 
convenience. The depth can also be entered no matter the number of 
pipes on the Pipe Depth & Loss Coefficients tab. The pipe table allows 
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you to specify entrance and exit loss factors for each pipe connected to 
the tank (in this case there is only one). The default selection is for the 
loss factors to be specified as zero. To change the loss factors later, click 
within the pipe table and enter the loss. 

The Optional tab allows you to enter different types of optional data. 
You can select whether the junction number, name, or both are displayed 
on the Workspace. Some junction types also allow you to specify an 
initial pressure as well as other junction-specific data. 

Each junction has a tab for notes, allowing you to enter text describing 
the junction or documenting any assumptions. 

The highlight feature displays all the required information in the 
Properties window in light blue. The highlight feature is on by default. 
You can toggle the highlight feature off and on by double-clicking 
anywhere in the window above the folder tabs or by pressing the F2 key. 
The highlight feature can also be turned on or off by selecting “Highlight 
in Pipe and Jct Windows” from the View menu. Note that the highlight 
feature is turned off in the Examples models. 

 Click OK. If “Show Object Status” is turned on, you should see the J1 
ID number turn black again, telling you that J1 is now completely 
defined. 

 Next, repeat this process for junctions J2 (Supply Tank B) and J5 
(Discharge Tank) with the following data for the Infinite 
Reservoir tank model:  

 For J2, use a Liquid Surface Elevation of 14 meters, a Pipe Depth of 
3 meters, and a Liquid Surface Pressure of 0 barG (0 kPa(g)) 

 For J5 use a Liquid Surface Level of 1.5 meters, a Pipe Depth of 1.5 
meters, and a Liquid Surface Pressure of 0 barG (0 kPa(g)) 

The Inspection feature 

You can check the input parameters for J1 quickly, in read-only fashion, 
by using the Inspection feature. Position the mouse pointer on the J1 
reservoir icon and hold down the right mouse button. An inspection 
window appears, as shown in Figure 2.10. 

Inspecting is a faster way of examining the input in an object than 
opening the Properties window. 
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Figure 2.10 Inspecting junction properties from the Workspace by 
clicking and holding the right mouse button 

B. Enter branch data  

 Open the J3 Branch Properties window and enter an elevation of 0 
meters. 

C. Enter valve data  

The J4 junction is a Valve junction. This junction will be the initiator of 
the transient. 

 Double-click the J4 junction icon to open the Valve Properties window 
(Figure 2.11) 

1. Enter an elevation of 0 meters 

2. Choose the Loss Model as Cv and enter a Cv of 1000 (this is the 
steady-state Cv) 

Inspection window 
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Figure 2.11 Input data for Valve junction J4 

3. Click the Transient tab and select Time under “Initiation of 
Transient” to indicate that the valve closure will be initiated at the 
time you specify, then enter the following Time vs. Cv data for the 
valve’s Cv at various times during the simulation (Figure 2.12). 

Time (sec) Cv 
0 1000 

0.4 400 
0.8 100 
1 0 
2 0 

The first data point (Cv = 1000 at time zero) must match the steady-
state value (entered in step 2). The transient data represents the valve 
as initially open. The valve then closes over a period of one second 
(a Cv of zero means the valve is closed). The valve then stays closed 
for the rest of the simulation. 
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Figure 2.12  Transient input data for Valve Junction J4 

When transient data is entered for a junction, a “T” symbol is shown next 
to the junction number on the Workspace. 

4. Click the OK button 

D. Enter pipe data for P1 

Data for pipes and junctions can be entered in any order. In this example, 
the junctions were done first. The next step is to define all the pipes. To 
open the Pipe Properties window, double-click the pipe object on the 
Workspace. 

 First, open the Pipe Properties window for Pipe P1. The Pipe Model 
folder tab opens by default (Figure 2.13).  

1. In the Pipe Material field, choose "Steel - ANSI" 

2. In the Size and Type fields, choose "10 inch" and "STD (schedule 
40)", respectively 

3. Specify the length as 60 meters 

4. For the Friction Model field, choose “Standard” 

5. Choose the Pipe Support as “Thick-Walled Anchored Upstream” 
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Figure 2.13  Properties window for Pipe P1 

The Pipe Properties window 

The Pipe Properties window offers control over all important hydraulic 
parameters that are related to pipes. 

The Inspect feature can be accessed not only from pipes and junctions 
located on the Workspace, but also from within the Properties window of 
each pipe (and certain junctions). This is helpful when you want to 
quickly check the properties of objects that connect to a pipe or junction 
whose Properties window you already have open.  

To Inspect a junction connected to a given pipe, position the mouse 
pointer on the connected junction's ID number in that pipe’s Properties 
window (located at the top right of the Pipe Properties window) and hold 
down the right mouse button. This process can be repeated for any 
junctions that state the upstream and downstream pipe in the junction’s 
Properties window by holding the right mouse button on the pipe’s ID 
number. 
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By double-clicking the connected junction number, you can jump 
directly to the junction's Properties window. Or you can click the Jump 
button to jump to any other part of you model. 

Wavespeed 

The wavespeed is a very important parameter in waterhammer analysis. 
The wavespeed can be calculated with reasonable accuracy from fluid 
and pipe data, or it may be available from test data or industry 
publications. If the wavespeed is not known (which is typical), then the 
Calculated Wavespeed option is the preferred option. In this case, data is 
required for pipe wall thickness, modulus of elasticity, Poisson Ratio, 
and pipe support details. Data for pipe wall thickness, modulus of 
elasticity, and Poisson Ratio are built into the pipe material databases 
supplied with AFT Impulse, and was automatically obtained when the 
Steel - ANSI, 10-inch, STD (schedule 40) option was chosen. The 
calculated wavespeed is 1279 meters/sec (Figure 2.13). 

E. Enter data for other pipes 

Similar to Pipe P1, enter the following data for the other pipes: 

Pipe Length 
(meters) 

Size 
 (inches) 

Pipe Support Friction Model 

1 60 10 Thick-Walled Anchored Upstream Standard 
2 45 10 Thick-Walled Anchored Upstream Standard 
3 15 12 Thick-Walled Anchored Upstream Standard 
4 12 12 Thick-Walled Anchored Upstream Standard 

 

F. Check pipes and junctions  

 Check if all the pipes and junctions are defined. If all data is entered, 
the “Define All Pipes and Junctions” Checklist item on the Quick Access 
Panel will have a check mark. If not, turn on the “Show Object Status” 
from the View menu or Workspace Toolbar icon, and open each 
undefined pipe and junction. The Status tab on each Properties window 
will indicate what information is missing. 

G. Review model data 

 Save the model one more time. It is also a good idea to review the input 
using the Model Data window. 
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Reviewing input in the Model Data window 

The Model Data window is shown in Figure 2.14. To change to this 
window, you can click on the Model Data tab, select it from the Window 
menu, or press Ctrl+ M. The Model Data window gives you a text-based 
perspective of your model. Selections can be copied to the clipboard and 
transferred into other Windows programs, exported into excel, saved to a 
formatted file, printed to an AdobeTM PDF, or printed out for review. 

Data is displayed in three general areas. The top is called the General 
data section, the middle is the Pipe data section and the bottom the 
Junction data section. Each section is collapsible using the buttons at the 
top left of the section. Further, each section can be resized. 

The Model Data window allows access to all Properties windows by 
double-clicking on any input parameter column in the row of the pipe or 
junction you want to access. You may want to try this right now. 

  

Figure 2.14  The Model Data window shows all input in text form 

Step 5. Complete the last two checklist requirements 

After completing the first three Checklist items, sufficient information 
exists to run the model in steady-state. The final two Checklist items are 
for transient modeling. To run the model in steady-state, select “Time 

General data 
section

Pipe data section

Junction data 
section
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Simulation” from the Analysis menu and then choose “Steady Only”. If 
one does this, the final two Checklist items are grayed out and the model 
can be run.  

In general, it is a good idea to always run your model in steady-state first 
before running the full transient analysis to make sure the model is 
giving reasonable results. 

A. Specify pipe sectioning 

The fourth Checklist item is Section Pipes. This window cannot be 
opened until sufficient data in the System Properties and Pipe Properties 
windows has been specified. This required data includes that the fluid 
must be selected (this was done in Step 3B when the System Properties 
were entered). Additionally, all pipes must have a length and wavespeed 
entered. After this data has been entered, the pipes can be sectioned. The 
Section Pipes window helps divide the pipes into computation sections in 
a manner which is consistent with the Method of Characteristics (MOC). 

Select Section Pipes on the Analysis menu to display the Section Pipes 
window (Figure 2.15). For this model, the controlling pipe is P4. This is 
the pipe with the shortest end-to-end communication time (i.e., L/a – the 
length divided by the wavespeed). To satisfy the MOC, the following 
equation must be applied: 

n
L

a ti
i

i


 

 

where n is the number of sections in pipe i, L is the length, and a is the 
wavespeed. The t is the time step. Since all pipes in the network must 
be solved together, the same time step must be used for each pipe. With a 
given length and wavespeed for each pipe, it can be seen from the above 
equation that it is unlikely that the number of required sections, n, for 
each pipe will be a whole number.  

To address this situation, it is helpful to recognize that the wavespeed, a, 
is the least certain input parameter. It is therefore generally considered 
acceptable to allow up to a 15% uncertainty in wavespeed. By adjusting 
the wavespeed for each pipe within this tolerance, the sectioning can be 
made to come out as whole numbers for each pipe. The Section Pipes 
window automates this process by searching for sectioning which 
satisfies the required tolerance. While a 15% variance in wavespeed is 
often acceptable, AFT Impulse uses 10% by default. 
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Figure 2.15 The Section Pipes window automates the sectioning 
process and calculates the time step 

When the Section Pipes window is first opened, it will automatically 
search for the best (least average variance) option for one to five sections 
in the controlling pipe. The results will be displayed in the table at the 
top. If more sections are needed, you can change the “Search up to” 
quantity and click “Update Results”. 

In this example model, the results when the controlling pipe has only one 
section show a maximum variance of 11%. Since this is greater than the 
default 10% threshold (shown when the “Show Advanced Settings” 
button is selected), the first row is colored red and was not automatically 
selected. The option to have two sections in the controlling pipe is 
selected since that has the fewest sections with an acceptable maximum 
variance. The time step is shown to be 0.00433 seconds. 

Results for one
to five pipe 

sections

Details for all
pipes when 2

sections in the
controlling pipe is

selected above
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Note that if the number of sections in the controlling pipe is doubled, the 
runtime increases roughly by a factor of four (twice the number of 
computations per time step and twice the number of time steps for the 
run). ). In this example, selecting four sections in the controlling pipe 
would result in the smallest variance in wavespeed modifications out of 
the options displayed, but the runtime would be four times that compared 
to the case where two sections are selected (16 times longer than with 
one section in the controlling pipe). Remembering that it is acceptable to 
have up to a 15% uncertainty in wavespeed, and that there are other 
uncertainties in the model, one would typically pick the option with the 
fewest sections with an acceptable maximum variance.  

B. Specify transient control 

The fifth and final Checklist item is Specify Transient Control. This 
window allows you to specify the time at which the transient starts and 
ends, as well as how much data to include in the output file. 

 Select Transient Control on the Analysis menu to display the 
Transient Control window (Figure 2.16). Enter 0 seconds in the Start 
Time field and 2 seconds in the Stop Time field.  

The Transient Control window allows you to enable or disable transient 
cavitation modeling and select which model to use. It also offers control 
over how AFT Impulse should respond to artificial transients. Artificial 
transients are a problem that can sometimes occur when steady-state and 
transient conditions are inconsistent. 

At the bottom of the window, the projected output file size is shown. 
You should pay attention to this number, as the output file size can grow 
very large. In this case, the output file will be 213 kB. If the output file 
does become excessively large, you will want to limit the number of time 
steps and pipe output written to disk. 

 Click OK to accept the current settings. The last Checklist item should 
be completed. The model is ready to be solved. 
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Figure 2.16 The Transient Control window offers features to 
specify the time span for the transient and what output 
data is written to disk 

C. Save the model 

Saving the model immediately before running it is always a good idea. 
Ensure that you save your model now. 

Step 6. Run the solver 

 Choose “Run Model…” from the Analysis menu or click the arrow 
icon on the Toolbar. During execution, the Solution Progress window is 
displayed (Figure 2.17). You can use this window to pause or cancel the 
Solver's activity.  
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Figure 2.17 The Solution Progress window displays the state of 
the simulation 

The two solvers 

AFT Impulse has two Solvers. The first is called the Steady-State Solver, 
which as its name suggests, obtains a steady-state solution to the pipe 
network. The second Solver is called the Transient Solver. This solves 
the waterhammer equations. 

Before a transient simulation can be initiated, the initial conditions are 
required. These initial conditions are the steady-state solution to the 
system. After the steady-state solution is obtained by the Steady-State 
Solver, AFT Impulse uses the results to automatically initialize the 
Transient Solver and then run it. 
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When the solution is obtained, click the Output button on the Solution 
Progress window to display the text-based Output window. The 
information in the Output window can be reviewed visually on the 
screen, saved to file, exported to a spreadsheet-ready format, copied to 
the clipboard, and printed out on a printer. 

The transient output file 

When the Transient Solver runs, the transient output data is written to a 
file. This file is given the same name as the model itself with a number 
appended to the name, and with an “.out” extension appended to the end. 
For all transient data processing, graphing, etc., the data is extracted from 
this file. The number is appended because AFT Impulse allows the user 
to build different scenarios all within this model. Each scenario will have 
its own output file; thus the files need to be distinguishable from each 
other.  

The output file will remain on disk until the user erases it or the input 
model is modified. This means that if you were to close your model right 
now and then reopen it, you could proceed directly to the Output window 
for data review without rerunning your model. 

Step 7. Review the Output window 

The Output window (Figure 2.18) is similar in structure to the Model 
Data window. Three areas are shown (including the general output 
section, the pipe output section, and the junction output section), and you 
can expand or collapse each area by dragging the boundary between the 
areas up or down, or by clicking the arrow beside the area label. The 
items displayed in the tables are those items you select in the Output 
Control window.  

The Output window allows you to review both the steady-state and 
transient results. The Pipes tab, All Junctions tab, and any specific 
junction tabs in the Junction output section (such as Branch, Reservoir, 
Valve, etc.) show the steady-state results. A summary of the maximum 
and minimum transient results for each pipe is given on the Transient 
Max/Min tab in the Pipe output section and is the active tab displayed in 
Figure 2.19. 
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Figure 2.18 The Output window displays steady and transient 
output in text form 

 

Figure 2.19 The Output window displays maximum and minimum 
transient data in the Transient Max/Min table 

You can also review the solutions for each time step (i.e., a time history) 
for which data was written to file on the Transient Output tab in the Pipe 
output section (Figure 2.20). Moving the slider along the bottom will 
change the time step shown in the table. 

General output 
section

Pipe output section

Junction output 
section
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Figure 2.20 The Output window displays transient data for each 
time step in the Transient Output table 

The Output Control window (Figure 2.21) allows you to select the 
specific output parameters you want to display in your output. You also 
can choose the units for the output. If you do not change any of the 
Output Control settings, default Output Control parameters and a default 
title are assigned. 

    
 

Figure 2.21 The Output Control window lets you customize the 
output 
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Units for each column in the Output section can also be changed by 
double-clicking the column header. This will open a window in which 
you can select the units again if you prefer (Figure 2.22). These changes 
are extended to the Output Control parameter data that is set. 

 

Figure 2.22 The Change Units window is opened from the Output 
window tables by double-clicking the column header 

Step 8. View the graph results 

For transient analyses, the Graph Results window will usually be more 
helpful than the Output window because of the more voluminous data. 

AFT Impulse’s Graph Guide feature, accessed by clicking on the “What 
Would You Like to Do?” button located at the top right of the Graph 
Area, provides assistance by guiding you through the creation of a 
“Quick and Simple” graph, or an “Advanced” graph (Figure 2.23). You 
can create a graph by following the prompts on the Graph Guide, or by 
manually specifying the graphing parameters on the Graph Control tab 
on the Quick Access Panel, or from the “Select Graph Parameters” icon 
located in the top left corner of the Graph Results Toolbar. For the 
remainder of this Quick Start Guide, the Graph Guide will be hidden, but 
remember that you can use it whenever you would like assistance in 
creating a graph.  

Figure 2.24 shows the Graph Results window with the Graph Control tab 
enabled on the Quick Access Panel. 
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Figure 2.23 The Graph Guide can be toggled on and off by clicking 
the “What Would You Like to Do?” button on the 
Graph Results window  

 

Figure 2.24 The Graph Results window and Quick Access Panel 
Graph Control tab is where various system parameters 
(both steady-state and transient) can be graphed 

AFT Impulse gives you the ability to create “stacked graphs”. These are 
graphs that are displayed on top of each other with the same X-axis but 
with different parameters on the Y-axis. This feature is very helpful 
when you want to look at how multiple parameters change in the same 
location of your model at the same time without having to create separate 
graphs. 
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In this example, you will create stacked graphs of the pressures and 
flows at the inlet and outlet of Valve J4 to see how these parameters 
change as the valve closes. 

 First, change to the Graph Results window by clicking on the Graph 
Results tab, by clicking “Graph Results” from the Solution Progress 
window after running the model, or by pressing Ctrl+G on the keyboard. 
The Graph Results window offers full-featured Windows plot 
preparation.   

 Access the graphing parameters by opening the Graph Control tab 
on the Quick Access Panel (this tab is automatically opened when the 
Graph Results window is opened). Because you are interested in seeing 
how the pressures and flows in specific pipe sections respond over time, 
ensure that the Transient Pipe tab is selected in the Parameters/ 
Formatting area on the Quick Access Panel. Alternatively, you can open 
the Select Graph Parameters window by clicking on the corresponding 
icon on the Graph Results Toolbar (this is the first icon located above the 
top left corner of the Graph area). 

 Under the “Select Pipe Stations” on the Transient Pipe tab, expand 
the P3 pipe stations and double-click on Outlet, which is the pipe 
computing station at the valve inlet. Alternatively, you can click on the 
right arrow button after selecting the pipe station you want to graph to 
add it to the “Graph These Pipes/Stations” list. Also add the inlet of Pipe 
P4 which is the valve exit. 

 Select seconds for the Time Units, and select “All Times” next to 
“Time Frame”. 

 In the Parameters definition area, select “Pressure Static” and 
choose “barG” in the dropdown box under “Units” to graph the static 
pressure in barG at the valve inlet and outlet over time. 

 In order to add the stacked graph over the static pressure graph  
showing the volumetric flowrate at the inlet and outlet of Valve J4, 
click the “Add” button, which has the green “+” icon next to “Select 
Parameter”. A new row under the Parameter definition area will appear 
(See Figure 2.25). 

 Choose “Volumetric Flowrate Upstream” in this new parameter 
row, and select units of “m3/hr”. 

 Click Generate at the bottom of the Quick Access Panel to create the 
static pressure and volumetric flowrate graphs at the inlet and outlet of 
the valve over the duration of the simulation. 
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 To format the legend font size, right-click on each legend and use the 
scroll bar next to decrease the font size to 9 for both graphs. Drag the 
legend to the upper right corner of the graph. 

 To format each axis font size, right click on each axis title and use 
the scroll bar to decrease the size until the font size on each axis appears 
as you want it. 

Figure 2.25 shows the input in the Parameters/ Formatting area on the 
Quick Access Panel. 

Figure 2.26 shows the stacked graphs detailing the static pressures and 
volumetric flowrates at the Valve J4 inlet and outlet over 2 seconds. Here 
you can see that the maximum pressure at the valve inlet is about 1.1 
barG. It should be noted that these graphs could also be made from the 
Transient Jct tab. In this case, the inlet and outlet pressures at the valve 
would be selected separately. 

  

Figure 2.25 The Graph Control tab on the Quick Access Panel 
allows you to specify the graph parameters you want 
to graph in the Parameters/Formatting area 

The “Add a 
new Stacked 
Graph” button 
adds another 
parameter to 
your graph 
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Figure 2.26 The Graph Results window offers full-featured plot 
generation. Here the static pressure and volumetric 
flow at the Valve J4 inlet and outlet are shown over 2 
seconds. 

The graph colors, fonts and other elements can be modified using the 
Formatting area on the Graph Control tab on the Quick Access Panel.  
The Graph Results window can be printed, saved to file, copied to the 
clipboard, or printed to an Adobe PDF file. The graph’s x-y data can be 
exported to file or copied to the clipboard. 

Further review 

Further review of the valve graph results in Figure 2.26 shows that at 
time zero, the pressure difference between the top and bottom curves of 
the pressure graph is about 1.1 barG. This is the steady-state pressure 
difference across the valve, which can also be found in the Output 
window to be 1.096 barG. 

As time increases, one sees that the two curves move further apart, which 
represents the increased pressure drop across the valve as it closes. At 1 
second, the valve closes entirely and the pipes upstream and downstream 
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of the valve are isolated from each other and will decay to the steady-
state conditions which exist for a closed valve. 

For the purpose of analysis, it would also be useful to view the 
volumetric flow rate from each supply tank over time.  

 Create a new graph tab by clicking the “New Tab” button which is the 
green plus icon located on the bottom right, immediately below the graph 
area (Figure 2.27) 

 Open the Transient Pipe tab on the Graph Control tab of the Quick 
Access Panel. Add the P1 and P2 inlet pipe stations to the “Graph These 
Pipes/Stations” list. 

 Select “seconds” in the Time Units section and “All Times” in the 
Time Frame section to graph the volumetric flowrate over the entire 
simulation duration. 

 Select Volumetric Flowrate Upstream and specify the units as “m3/hr”. 

 Click the Generate button to display the graph. A graph of these 
stations shows the flowrates out of the two supply reservoirs. Note that 
after the valve closes, the fluid in Reservoir J1 flows to Reservoir J2 
(Figure 2.27). 

 

Figure 2.27 Transient flowrates out of the reservoirs  

The “New 
Tab” button 
creates a new 
graph tab 
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Note: AFT Impulse allows you to quickly generate several types of 
graphs by right-clicking on pipes or junctions on the Workspace after 
your model has output. To quickly generate the static pressure plot at the 
Valve J4 inlet and outlet, you can right-click on Valve J4 on the 
Workspace, then select “Create Transient Graph for connected pipes 
(Inlet/Outlet)”, then select Pressure Static. To add the volumetric 
flowrate stacked graph, or to modify any units or other graph parameters, 
access the Graph Control tab on the Quick Access Panel and adjust the 
graph parameters as desired.   

Step 9. View the Visual Report 

The Visual Report allows you to show text output alongside the model 
schematic. This is useful to quickly show pertinent information in 
relation to the location in the model. The Visual Report can also animate 
the transient pipe results in a color animation overlaid on the model. 

 Change to the Visual Report window by clicking on the Visual Report 
tab, choosing it from the Window menu, or pressing Ctrl+I. This window 
allows you to integrate your text results with the graphic layout of your 
pipe network. 

 Click the Visual Report Control button on the Visual Report 
Toolbar (or Tools menu) and open the Visual Report Control window, 
shown in Figure 2.28. Default parameters are already selected, but you 
can modify these as desired. For now, select “Max Pressure Stagnation” 
and “Min Pressure Stagnation” in the Pipe Results area. Click the Show 
button. The Visual Report window graphic is generated (Figure 2.29). 

It is common for the text in the Visual Report window to overlap when 
first generated. You can change this by selecting smaller fonts or by 
dragging the text to a new area to increase clarity.  You can also use the 
Visual Report Control window to display units in a legend to increase the 
clarity of the display.  These adjustments have already been done in 
Figure 2.29. This window can be printed or copied to the clipboard for 
import into other Windows graphics programs, saved to a file, or printed 
to an Adobe PDF file. 
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Figure 2.28 The Visual Report Control window selects content for 
the Visual Report window 

The Visual Report window also provides the ability to animate the 
transient results as a qualitative tool to visualize the behavior in a 
network. This option can also be accessed from the Visual Report 
Control by selecting the Animate Display Mode at the top of the window 
(see Figure 2.28). When using the animation mode, text results cannot be 
displayed for the report. Instead, one parameter can be animated using 
absolute values or values relative to the steady state, or a static map of all 
maximum/minimum transient values can be generated. The animation 
can be recorded to a file. The model setup for animating static pressure 
can be seen in Figure 2.30. 

Conclusion 

The maximum pressure at the valve’s inlet during the valve closure is 
approximately 5.1 bar. You have now used AFT Impulse's five Primary 
Windows to build a simple waterhammer model. 
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 Figure 2.29 The Visual Report integrates results with model layout 

 

Figure 2.30  The Visual Report provides an animation feature as an 
alternate way to view the transient results 

 

Click here to 
open the Visual
Report Control

Click and drag text 
to preferred 

location 

 

Units may be
displayed in a

legend

Animation toolbar
provides controls

to play and adjust
animation

Visual Report 
Animation tab 

adjusts Animation 
parameters and 

scale 

Legend and 
Time boxes can 

be moved 



C H A P T E R  3  

Pump Startup With Event Transients 

This example looks at three pump startup cases for a water transfer 
system. The objective is to determine the maximum pressures in the 
system and to assess whether the system cavitates or experiences sub-
atmospheric pressure. 

Topics covered 

This example will cover the following topics: 

 Starting one or more pumps 

 Using steady-state and transient special condition features 

 Using event transients 

 Using Scenario Manager 

 Adding graphs to the Graph List 

 Using Graph Animation 

Required knowledge 

This example assumes that the user has some familiarity with AFT 
Impulse such as placing junctions, connecting pipes, entering pipe and 
junction properties, and entering transient data. Refer to the Valve 
Closure Example in Chapter 2 for more information on these topics. 
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Model file 
This example uses the following file, which is installed in the Examples 
folder as part of the AFT Impulse installation: 

 Pump Startup With Event Transient_Metric.imp 

Problem Statement 

This problem contains two pumps in parallel that transfer water from a 
supply reservoir to two process tanks downstream. The following three 
different pump startup scenarios are to be modeled and evaluated: 

1. Both pumps starting 

2. One pump starting 

3. One pump starting with the other pump already running 

As the design engineer, you will evaluate these three scenarios to 
determine the maximum and minimum system pressures, as well as use 
the animation features in Impulse to understand how the system will 
respond in each case. 

Step 1. Start AFT Impulse 

From the Start Menu choose AFT Products and AFT Impulse. 

Step 2. Specify system properties 

1. Open the System Properties window by selecting “System 
Properties” in the Analysis menu. 

2. On the Fluid Data Tab, select the AFT Standard database and then 
select "Water at 1 atm" in the “Fluids Available in Database” 
window. 

3. Click "Add to Model" to select water for use in this model. 

4. Specify 16 deg. C in the Temperature field and click "Calculate 
Properties". This calculates the fluid properties to use in the model. 

5. Click OK 
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Note: The Fluid Data can also be specified in the Startup window when 
AFT Impulse is first opened. 

Step 3. Build the model 

A. Place the pipes and junctions 

At this point, the first two items are completed on the Checklist. The next 
Checklist item is to "Define All Pipes and Junctions". In the Workspace 
window, assemble the model as shown in Figure 3.1. 

 

Figure 3.1 Layout of pipe system for pump startup example 

B. Enter the pipe and junction data  

The system is in place, but now the input data for the pipes and junctions 
need to be entered. Double-click each pipe and junction and enter the 
following data in each Pipe and Junction Properties window. Pipes P1-
P11 are Steel – ANSI, STD, Thick-Walled Anchored Upstream, and the 
following data: 
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Pipe Name Length 
(meters) 

Size 
(inches) 

Friction  
Model 

1 Suction Pipe Pump #1 15 10 Standard 
2 Discharge Pipe Pump #1 6 10 Standard 
3 Pipe 6 10 Standard 
4 Suction Pipe Pump #2 18 10 Standard 
5 Discharge Pipe Pump #2 6 10 Standard 
6 Pipe 6 10 Standard 
7 Pipe 30 16 Standard 
8 Line to Process #1 Tank 76 12 Standard 
9 Line to Process #1 Tank 61 12 Standard 
10 Line to Process #1 Tank 366 12 Standard 
11 Line to Process #2 Tank 1524 12 Standard 

J1 - Reservoir  

1. Name = Supply Reservoir 

2. Liquid Surface Elevation = 6 meters 

3. Liquid Surface Pressure = 0 barG (0 kPa (g)) 

4. Pipe Depth = 6 meters  

J10 - Reservoir 

1. Name = Process #1 Tank 

2. Liquid Surface Elevation = 30 meters  

3. Liquid Surface Pressure = 0 barG (0 kPa (g)) 

4. Pipe Depth = 3 meters 

J11 - Reservoir 

1. Name = Process #2 Tank 

2. Liquid Surface Elevation = 3 meters 

3. Surface pressure = 0 barG (0 kPa (g)) 

4. Pipe Depth = 3 meters 

J4, J7 and J8 - Branch  

Elevation = 0 meters 
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J2 and J5 - Pumps  

1. J2 Name = Transfer Pump #1 

2. J5 Name = Transfer Pump #2 

3. Elevation = 0 meters 

4. Pump Model = Centrifugal (Rotodynamic) 

5. In the “Reverse Flow” area choose “Never”, as the pump discharge 
valves are designed to prevent reverse flow through the pumps.  

6. Click the “Enter Curve Da” tab and enter the following data: 

Q (m3/hr) dH (m) 
0 45.7 

227 42.7 
454 36.6 

7. In the Curve Fitting area, click the “Generate Curve Fit Now” button. 
Then click the OK button 

8. On the Transient tab, select “Speed vs. Time” under “Without 
Inertia” for the transient type 

9. Enter the following data for pump speed to specify that the pumps 
will come up to speed in two seconds 

Time (sec) Speed (%) 
0 0 
2 100 

10 100 

10. On the Optional tab, select the Special Condition as “Pump Off With 
Flow Through”. This indicates that initially the pump is turned off, 
but flow can go through it during steady-state. Valve junctions will 
be used to prevent any steady-state flow 

J3 and J6 - Valves  

1. J3 Name = Valve #1 

2. J6 Name = Valve #2 

3. Elevation = 0 meters 

4. Cv = 1000  
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5. On the Transient tab, enter the following data: 

Time (sec) Cv 
0 0 
1 800 
2 1000 

10 1000 

6. On the Optional tab, select the Special Condition as Closed. (When 
you close the valves, the adjacent pipes are displayed with dashed 
lines to denote that the pipes are closed) 

J9 - Valve 

This valve will use what is called an event transient. This means that the 
time zero in the Transient Data table is with respect to some condition 
occurring in the system. If the condition is never reached, the valve 
transient is never initiated. Here the valve should open when the pressure 
at Branch J7 is sufficient to cause the water to flow into Reservoir J10. 
There is no "Junction Pressure" for the “Initiation of Transient”, but there 
is one for pipes. Use one of the pipes connected to Branch J7 as a basis 
for the event. 

1. Name = Valve to Process #1 Tank 

2. Elevation = 0 meters 

3. Cv = 500  

On the Transient tab, enter the following data (Figure 3.2) 

Time (sec) Cv 
0 0 
2 400 
3 500 
10 500 

In the “Initiation of Transient” area select “Single Event” 

4. Event Type = Pressure Stagnation at Pipe 

5. Condition = Greater Than 

6. Value = 3.10 barG 

7. Pipe = 7, Outlet 

8. On the Optional tab, select the Special Condition as Closed 
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Note: Multiple condition events for the transient can be defined by 
selecting Multi-Condition for the Event Type, then using the Multi-
Condition Event Manager to group the events. 

 

Figure 3.2 Specifying an event transient for Valve J9 

C. Check if the pipe and junction data is complete 

Turn on “Show Object Status” from the View menu to verify if all data is 
entered. If so, the third Checklist item will have a check mark. If not, the 
pipe or junction number of any uncompleted pipes or junctions will be 
shown in red. If this happens, go back to the uncompleted pipes or 
junctions and enter the missing data.  
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Note: Red is the default color that shows what objects are undefined in 
your model when Show Object Status is active. This color is 
configurable in the User Options. 

Step 4. Section the pipes 

Open the Section Pipes window from the Analysis menu. When the 
Section Pipes window is first opened, it will automatically search for the 
best (least average variance) option for one to five sections in the 
controlling pipe. The results will be displayed in the table at the top. 
Click OK to accept the displayed sectioning. 

Step 5. Specify transient control 

1. Open the Transient Control window from the Analysis menu 

2. Enter the Start Time as 0 seconds and the Stop Time as 10 seconds 
on the Transient Solver Control tab  

3. Clear the checkbox for Model Transient Cavitation on the Transient 
Solver Control tab (cavitation will be ignored until it becomes clear 
that it should be modeled) 

4. To minimize run time and output file size, the table on the Pipe 
Station Output tab uses “Inlet and Outlet” for all pipes by default. 
This will cause the output for only the inlet and outlet station of each 
pipe to be saved to file. Data can be saved for all pipe stations or 
only selected stations. Click the All button to select all the pipes in 
the table. Drop down the list next to the “Change Selected Pipes To” 
button and select “All Stations”. Then click the “Change Selected 
Pipes To” button (Figure 3.3). This will save all pipe station data for 
all pipes, which will be useful later for animation purposes 

5. Click the OK button 



Chapter 3   Pump Startup With Event Transients   57 

 

Figure 3.3 Transient Control window pipe station selection 

Step 6. Create scenarios to model the three startup cases 

A. Create scenarios 

In this model, the following three pump startup cases are to be evaluated: 

1. Both pumps starting  

2. One pump starts while the other pump stays off 

3. One pump starts while the other is already running 

Three scenarios need to be created to model the three cases. 

The Scenario Manager is a powerful tool for managing variations of a 
model, referred to as scenarios. The Scenario Manager allows you to: 

 Create, name and organize scenarios 

 Select the scenario to appear in the Workspace (the ‘current’ 
scenario) 

 Delete, copy and rename scenarios 

 Duplicate scenarios and save them as separate models 
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 Review the source of a scenario’s properties 

 Pass changes from a scenario to its variants 

You will create three scenarios to model these cases. Scenarios are 
created using the Scenario Manager from the Tools menu or the Scenario 
Manager on the Quick Access Panel. The Quick Access Panel, located 
on the right side of the Workspace area, contains the Scenario Manager 
on the Scenario tab. A scenario tree displays all model scenarios.  

Click the "Create Child" button on the Scenario Manager on the Quick 
Access Panel. Name the child “Two Pump Start”. A new scenario will 
appear below the Base Scenario in the scenario tree. Select the Base 
Scenario, create another child, and call it “One Pump Start”. Finally, 
create a third child called “One Pump Start With One Running” (see 
Figure 3.4). Note that the new child scenario is loaded when it is created 
using the Scenario Manager on the Quick Access Panel. 

 

Figure 3.4 The Scenario Manager on the Quick Access Panel 
displays the scenario tree that allows you to create 
model variants (scenarios) and keep them organized 
within the same model file 
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B. Set up scenarios 

Child scenarios “inherit” data from their ancestors. As long as the data 
has not been modified in a child scenario, data parameters in the child 
scenario will have the same value as their parent. Since the Base 
Scenario already has been setup with two pumps starting, the “Two 
Pump Start” child does not need to be modified.  

One Pump Start 

Double-click the “One Pump Start” scenario in the scenario tree of the 
Scenario Manager on the Quick Access Panel. This will load the “One 
Pump Start” scenario onto the Workspace as the current scenario. The 
currently loaded scenario is displayed in the scenario tree with a green 
check mark (Figure 3.4). 

Here, only Pump J2 will be started while keeping Pump J5 off. Deleting 
the transient input data for Pump J5 and Valve J6 will keep these two 
junctions turned off because their special conditions specify that they are 
off. Alternatively, their transient data can be set to be ignored. The 
second option is what will be done here.  

 Open the J5 Pump window. Click on the Transient tab, then choose the 
“Ignore Transient Data” option in the “Transient Special Condition” area 
as shown in Figure 3.5 then click OK. Do the same with the J6 Valve. 
The required input for this scenario is now complete.  

 

Figure 3.5  Transient Special Condition section on the Transient 
tab of the Pump Properties window. 

One Pump Start With One Running  

Double-click the “One Pump Start With One Running” scenario from the 
scenario tree in the Scenario Manager on the Quick Access Panel. This 
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will load the “One Pump Start With One Running” scenario onto the 
Workspace as the current scenario. This step can also be accomplished 
by opening the Scenario Manager from the Tools menu, selecting the 
“One Pump Start With One Running” scenario in the scenario tree and 
then clicking the “Load As Current Scenario” button.  

Here, Pump J2 will be running at 100% speed during the steady-state and 
transient, and Pump J5 will be started.  

 Open the J2 Pump window and select the Optional tab. Set the Special 
Condition to “None”. This specifies that during the steady-state the pump 
will be on and operate on its curve.  

 Select the Transient tab and set the Transient Special Condition to 
“Ignore Transient Data”, since this pump will run at 100% speed during 
the transient. Alternatively, the speed data could be deleted. 

The Special Condition for Valve J3 also needs to be set to “None”, and 
the Transient Special Condition on the Transient tab set to “Ignore 
Transient Data” by following the two steps above in the J3 Valve 
Properties window. 

The required input for this scenario is now complete. 

Step 7. Run the first scenario  

Double-click the “Two Pump Start” scenario from the scenario tree in 
the Scenario Manager on the Quick Access Panel. Select “Run Model” in 
the Analysis menu. After the model has finished running, view the 
results by pressing “Output” at the bottom of the Solution Progress 
window.  

Note that several warnings in red appear in the Output stating that several 
pipes listed use constant friction factors, and that Variable Pipe 
Resistance is recommended. The variable pipe resistance can be turned 
on from the Transient Solver Control tab in the Transient Control 
window. 

As background to this warning, traditional waterhammer modeling has 
ignored the effect of varying pipe resistance (i.e., friction) with flowrate. 
This is for several reasons. First, for highly turbulent flow (i.e., large 
Reynolds numbers) the pipe resistance does not depend on flowrate at 
all. On Moody charts this is sometimes referred to as the "fully rough 
zone". Second, for turbulent flows that are not in the fully rough zone, 
the dependence of pipe resistance is weak. Third, the waterhammer 
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phenomenon is not affected very much by relatively small changes in 
pipe resistance. And finally, introducing varying pipe resistance requires 
more steps in the calculation process.  

Therefore, accounting for varying pipe resistance is not important in 
many waterhammer applications. One application where it is important is 
when the initial steady conditions have no flow in some pipes. For 
instance, when the transient being modeled is a pipe with a closed valve 
which is being opened. In such cases, it is difficult to obtain the steady-
state pipe resistance because the flow is zero and thus no Reynolds 
number exists. Thus it is probably best to use variable resistance.  

If you choose to not use variable resistance, the pipe frictional resistance 
obtained in the steady-state part of the simulation will be used as a 
constant in the transient part of the simulation. On the other hand, if you 
allow the resistance to vary, the pipe friction will differ for each pipe 
section because the flowrate (and hence Reynolds number) is varying 
along the pipe due to the waterhammer transient. Further, the resistance 
will vary with time as the flowrate changes. 

If variable resistance is modeled, the required run time increases. 
Experience suggests the run time increases by about a factor of three. 

For the three scenarios in this chapter, using variable pipe resistance does 
not significantly affect the results. 

Step 8. Graph the results 

Change to the Graph Results window by clicking on the Graph Results 
Primary Window tab, by clicking “Graph Results…” from the Solution 
Progress window after running the model, or by pressing Ctrl+G on the 
keyboard.  

1. From the Graph Control tab on the Quick Access Panel, select the 
Profile tab 

2. Next to Pipes, select “Plot Single Path” 

3. Select pipes 1, 2, 3, 7 and 11 to specify the path from the supply 
reservoir to Reservoir J11. Alternatively, you can select all these 
pipes on the Workspace by holding SHIFT while clicking on all 
pipes in the path, then returning to the Graph Results tab and 
selecting “Workspace” to automatically choose all pipes currently 
selected on the Workspace 
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4. Choose “meters” for the Length Units 

5. In the Parameters definition area, select “Pressure Static” and specify 
“barG” in the dropdown box under “Units” 

6. Ensure that the boxes in the Mx and  Mn columns are selected (these 
indicate that your graph will display the maximum and minimum 
pressures, respectively) 

7. Click the Generate button 

Results (shown in Figure 3.6) indicate that the peak pressure occurs at 
the pump discharge, and that the minimum pressure is above atmospheric 
pressure at all times.  

You can show the location of junctions within the pipeline path that you 
have plotted. Click the “Show Junction Locations” icon on the Graph 
Results Toolbar (see Figure 3.6). 

 

Figure 3.6  Profile of the maximum and minimum pressures 
through Pump #1 to Process #2 Tank for Two Pump 
Start scenario 

To easily recreate this graph in other scenarios or in the future, it can be 
added to the Graph List. This can be done using the Graph List Manager 
on the Quick Access Panel. After generating the graph, click the “Add 
Graph To List” button on the Graph Results Toolbar (this icon is a blue 

The “Show
Junction

Locations” icon
shows the

locations of
junctions along

the selected
flow path
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“+” sign on top of a file folder image). Give the graph a name like 
“Pressure Profile Pump #1 to Process #2 Tank”. The graph will be added 
to the currently selected folder in the Graph List Manager. Note that 
graphs added to the Graph List Manager are not permanently saved until 
the model itself is saved again. 

The profile through the other flow paths (there are four paths altogether) 
can also be plotted, and similar conclusions are obtained. Add the other 
three paths to the Graph List. 

Since the maximum pressure is at the pump discharge, it is of interest 
here to plot the pressure vs. time. The volumetric flowrate vs. time at the 
pump discharge is also of interest. You will use AFT Impulse’s dual Y-
axis graphing abilities to plot both the pressure and volumetric flowrate 
vs. time on the same graph to observe how the pressure and flow change 
at the same time. 

1. From the Graph Control tab, choose the Transient Jct tab in the 
Parameters/Formatting area and add pumps J2 and J5 to the “Graph 
These Junctions” list. 

2.  Ensure that the Time Units is set to “seconds” and the Time Frame 
is set to “All Times”. 

You will need to decide what parameter you wish to plot on the primary 
Y-axis and which parameter you want to plot on the secondary Y-axis. In 
this example, we will plot pressure on the primary Y-axis and volumetric 
flowrate on the secondary Y-axis.  

3. To do this, select “Pressure Static Outlet” in the Parameters 
definition area and choose “barG” as the units  

4. Add a parameter by clicking on the “Add” button next to “Select 
Parameter” in the Parameter definition area 

5. Change this added parameter to “Vol. Flow Rate Outlet” and choose 
“m3/hr” as the units 

6. To specify that the volumetric flowrate will be plotted on the 
secondary Y-axis, click the “Make Secondary Y-Axis” button, which 
is the blue, right arrow icon located to the top right over the selected 
parameters. Alternatively, you can double-click on the column in 
front of “Vol. Flow Rate Outlet ” in the Parameter definition area. 
Note that “Vol. Flow Rate Outlet ” becomes indented under 
“Pressure Static Outlet”, and that the black arrow next to “Vol. Flow 
Rate Outlet” turns to point towards the graph. See Figure 3.7 to see 
how these graphing parameters are defined. 
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Figure 3.7  Parameter definitions for dual Y-axes graph of static 
pressure (primary Y-axis) and volumetric flowrate 
(secondary Y-axis) on the Graph Control tab on the 
Quick Access Panel 

Click the Generate button. You will see that the transient pressures at the 
pump discharge are plotted versus time on the primary Y-axis, and the 
volumetric flowrate vs. time is plotted on the same graph on the 
secondary Y-axis.  

As would be expected, the pressure and volumetric flowrate transients 
are very similar for both pumps. The resulting graph is shown in Figure 
3.8. Add this graph to the Graph List. 
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Figure 3.8 Pressure and volumetric flowrate transients at both 
pump discharge locations for Two Pump Start 
scenario 

The flowrates into the two process tanks are of interest.  

1. From the Transient Pipe tab on the Graph Control tab, click the 
double left arrow button between the “Select Pipe Stations” list and 
“Graph These Pipes/Stations” list to clear all selections from the 
“Graph These Pipes/Stations” list  

2. Then, add the outlet of Pipes P10 and P11 from the “Select Pipe 
Stations” list to the “Graph These Pipes/Stations” list  

3. Select “Volumetric Flowrate” from the Parameter list 
4. Because you are only graphing the volumetric flowrate, ensure that 

any other parameters are removed from the Parameter definition 
area. If there are any other parameters here, be sure to select the 
parameter and then click the red “X” remove button 

5. Choose units of m3/hr 
6. Click the Generate button 

Results are shown in Figure 3.9. Add this plot to the Graph List. 
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Figure 3.9 Flowrate transient at process tanks for Two Pump 
Start scenario 

Step 9. Animate the results 

AFT Impulse can animate hydraulic parameters along pipeline paths in 
your model. This feature is very helpful when trying to understand how 
your system will respond when a transient event occurs. You can also 
animate multiple graphs at the same time.  

Here, you will animate the pressure and volumetric flowrate responses 
along the path you previously graphed to gain an understanding of how 
these hydraulic parameters respond as the pumps start up. To animate 
these parameters: 

1. Select the Profile tab under the Graph Control tab on the Quick 
Access Panel. Alternatively, you can access the Select Graph 
Parameters window by clicking on the “Select Graph Parameters” 
icon located at the top left of the Graph Results window.   

2. Select pipes 1, 2, 3, 7 and 11 
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3. Add a second parameter in the Parameters definition area, and 
specify one parameter to be “Pressure Static” and the other to be 
“Volumetric Flowrate”.  

4. As was done in Step 8, specify that the volumetric flowrate will be 
plotted on the secondary Y-axis by double-clicking on the column in 
front of “Volumetric Flowrate” in the Parameters definition area. 
Note that “Volumetric Flowrate” becomes indented under “Pressure 
Static”, and that the black arrow next to “Volumetric Flowrate” turns 
to point towards the graph (Figure 3.10) 
 
Note: AFT Impulse provides the flexibility to simultaneously 
animate stacked graphs, as well as graphs with dual Y-axes plotted. 
In this example, you will animate the static pressure and volumetric 
flowrate displayed on dual Y-axes. 

5. Choose the Length Units to be meters 

6. Next to Animate Using, specify “Output”, and specify “seconds” 
next to Animation Time Units (see the following paragraph for an 
explanation about this option) 

7. Change the pressure units to barG and the volumetric flowrate units 
to m3/hr 

8. Specify for both the static pressure and volumetric flowrate graphs 
that you want to see the maximum and minimum values plotted 
along the length of the graphed path by placing a checkmark in the 
boxes in the Mx and Mn columns next to each parameter (See Figure 
3.10) 

To use the “Animate Using: Output” option for animation, which is done 
here, all pipe stations need to be saved in Transient Control (Step 5: 
Specify transient control). In addition, it frequently is best to save all 
time step data as well. Both of these were selected previously. This 
animation option has the most flexibility to start, pause, and restart 
animation. 

Another animation option in Figure 3.10 is “Animate Using: Solver”. 
This option actually reruns the Transient Solver to generate the data for 
animation, and thus does not need to read it from file. Therefore, it does 
not require all of the data to be saved in Transient Control. 
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Figure 3.10 Selecting animation in Graph Results for Two Pump 
Start scenario 

Click the Generate button. Additional animation control features appear 
on the Graph Results window (Figure 3.11). Press the Play button and 
watch the pressure waves and volumetric flowrate responses move 
between the maximum and minimum values. This animation can also be 
recorded to a file. 

Step 10. Run the other scenarios and graph the results 

Using Scenario Manager, load the other two scenarios and run them. 
Then create graphs similar to Figures 3.6-3.9. This will reveal that the 
maximum pressure for the “One Pump Start” scenario occurs at the 
pump discharge location, similar to the first scenario, but in the “One 
Pump Start With One Running” scenario the maximum pressure occurs 
in Pipe P11. Also, the pressure drops below atmospheric pressure, but 
does not reach the vapor pressure of water. 
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Figure 3.11  Animating output in Graph Results for Two Pump Start 
scenario 

In the “One Pump Start With One Running” scenario, it should also be 
noted that there is a warning given for the pump. This is indicated by the 
red message in the status bar. The warning can be viewed in the top third 
section of the Output window on the Warnings tab, and states that there 
was reverse flow at pump junction J5. This warning message indicates 
that though reverse flow was not expected at pump J5, the calculations 
for the model found that reverse flow would occur at this point. It is 
recommended to adjust the model to better account for this reverse flow. 

Depending on the system, there are several actions that may be 
appropriate. One change may be to adjust model inputs such as the 
discharge valve closure profile to prevent reverse flow to the pump. This 
is only acceptable if the changes are physically accurate for the system. 
Otherwise, it will be necessary to choose an appropriate four quadrant 
data set for the pump to accurately predict the head at reverse flow 
conditions. This will be discussed further in the next chapter. 
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Conclusion 

The numerical maximum pressure can be found at the bottom of the 
General data section in the Output window of each scenario and is 
summarized in Table 3.1 for all three scenarios. For these cases, the 
maximum pressures do not significantly differ from each other. 

Table 3.1 Summary of maximum static pressure for the three 
cases 

Case Max. Static 
Pressure  
(barG) 

Two Pumps Start 5.01 
One Pump Start 4.92 
One Pump Start With One On 5.01 
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Pump Trip Example 

Summary  

This example evaluates two parallel pumps tripping in a cooling tower. 
Various discharge valve closure times are analyzed to examine the 
impact on the system when the valves close quickly enough to prevent 
reverse rotation at the pump, and when the valves do not close 
completely before reverse rotation occurs in the pump. 

Topics covered 

This example will cover the following topics: 

 How to specify a pump curve and power curve in the Pump 
Properties window 

 How to use one of the transient pump models which accounts for 
pump inertia 

 Use of Four Quadrant Data to model reverse flow and reverse 
rotation in the pump.  

Required knowledge 

This example assumes that the user has some familiarity with AFT 
Impulse such as placing junctions, connecting pipes, entering pipe and 
junction properties, and entering transient data. Refer to the Valve 
Closure Example in Chapter 2 for more information on these topics. 



72   AFT Impulse 7 Quick Start Guide 

Model files 

This example uses the following file, which is installed in the Examples 
folder as part of the AFT Impulse installation: 

Pump Trip With Backflow_Metric.imp 

Problem Statement 

In this problem, two parallel pumps in a cooling tower lose power, 
causing the pumps to trip. It is desired for the valves at the discharge of 
the pumps to close quickly enough to prevent reverse rotation in the 
pumps. You will evaluate the maximum and minimum pressures 
experienced in the system during this pump trip event. 

Furthermore, you will look at the case where the minimum valve closure 
time is determined to be 12 seconds, in which case reverse rotation will 
occur at the pump. 

Step 1. Start AFT Impulse  

From the Start Menu choose AFT Products and AFT Impulse. 

Step 2. Specify system properties 

1. Open the System Properties window by selecting System Properties 
in the Analysis menu 

2. On the Fluid Data Tab, select the AFT Standard database and then 
select "Water at 1 atm" in the “Fluids Available in Database” 
window 

3. Click "Add to Model" to select water for use in this model 

4. Specify 38 deg. C in the Temperature field 

5. Click "Calculate Properties" 

This calculates the fluid properties to use in the model.  

Note: The Fluid Data can also be specified in the Startup window when 
Impulse is first opened. 
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Step 3. Build the model 

A. Place the pipes and junctions 

At this point, the first two items are completed on the Checklist. The next 
Checklist item is to "Define All Pipes and Junctions". In the Workspace 
window, use the Toolbox on the left to drag and drop two reservoirs and 
a pump onto the Workspace. Then connect these with a pipe using the 
pipe drawing tool. The default flow direction will be from the first object 
you select to the second object. An arrow indicates the default flow 
direction. The Workspace should look like Figure 4.1. 

 

Figure 4.1 Workspace for pump trip example 

B. Enter the pipe and junction data 

The system is in place, but now the input data for the pipes and junctions 
needs to be entered. Double-click each pipe or junction and enter the 
following data in the Pipe or Junction Properties window.  

All pipes in the model will have Material = Steel – ANSI, standard 
roughness, and the pipe support as Thick-walled Anchored Upstream. 
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Pipe Name Length 
(meters)

Size 
(inches) 

Type 

1 Pipe 12 18 STD 
2 Pipe 12 18 STD 

11 Main Return 99 30 STD 
12 Main Return 11 30 STD 
21 CWP-1 Suction 3 20 STD(schedule 20) 
22 CWP-1 Discharge 3 20 STD(schedule 20) 
23 Pipe 3 20 STD(schedule 20) 
31 CWP-2 Suction 3 20 STD(schedule 20) 
32 CWP-2 Discharge 3 20 STD(schedule 20) 
33 Pipe 3 20 STD(schedule 20) 
41 Main Supply to CT 122 30 STD 

101 Pipe 12 20 STD(schedule 20) 
102 Pipe 12 20 STD(schedule 20) 

Reservoir J1 and J2 

1. Name = CT #1 Basin and CT #2 Basin 

2. Tank Model = Infinite Reservoir 

3. Liquid Surface Elevation = 12 meters 

4. Liquid Surface Pressure = 0 barG (0 kPa(g)) 

5. Pipe depth = 1 meter 

Branch J10 

Elevation = 11 meters 

Branch J20 and J40 

Elevation = 0 meters 

Branch J100 

Elevation = 15 meters 
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General Component J11 

1. Name = Surface Condenser 

2. Elevation = 0 meters 

3. Loss Model = Resistance Curve 

4. Click Enter Curve Data button and create a curve fit for the 
following data: 

Q (m3/hr) H (m) 

0 0
4542 6.7
9085 26.8

Pumps J21 and J31 

1. Name = CWP-1 and CWP-2 

2. Elevation = 0 meters 

3. Select Centrifugal (Rotodynamic) as the pump model, then click the 
Enter Curve Data Button and enter the following data: 

Q (m3/hr) H (m) Power (kW) 
0 34.1 78.3 

454 32.9 96.9 
908 31.7 119.3 

1363 29.9 141.6 
1817 27.4 156.5 
2271 23.8 164 
2725 18.3 156.5 

 
4. In the Curve Fitting area select the All button then click the Generate 

Curve Fit now button. Then click the OK button. 

6. In the Rated Pump Speed enter 1790 rpm. 

7. In the "Reverse Flow" area choose "Possible".  

8. Select Standard Pump Curve. 

9. Check the box to Model Combined Check Valve and Pump, then set 
the Forward Velocity and Delta Head both as zero. (Figure 4.2) 

10. On the Transient tab, select “Trip” under “With Inertia”  

11. Under Total Rotating Inertia choose User Specified = 5.9 kg-m2 



76   AFT Impulse 7 Quick Start Guide 

 

Figure 4.2 Pump Model tab for Pump J21. The internal check 
valve and flow behavior can be seen in the Flow 
Directional Behavior section. 

12. Set the Initiation of Transient to be "Single Event", for a Time 
Absolute greater than or equal to zero. 

Note: When reverse flow occurs at the pump, the Four Quadrant Model 
is recommended to obtain a better estimate for the head at reverse flow. 
To simplify the input, we will define the pump with the Standard Pump 
curve for now. In this case an internal check valve is required to prevent 
reverse flow, since there is not enough data in the standard curve to 
calculate the inertial pump trip if reverse flow did occur. We will come 
back later and compare these results to the Four Quadrant option. 

Valves J22 and J32 

1. J22 is named Valve #1 

2. J32 is named Valve #2 

3. Elevation = 0 meters 

4. Cv = 10,000  
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5. On the Transient tab enter the following data. 

Time (sec) Cv 

0 10000
3 1000
5 0
15 0

Spray Discharge J101 and J102 

These junctions each represent numerous spray nozzles that are modeled 
as a single nozzle for simplicity. 

1. Name = CT #1 and CT #2 

2. Elevation = 24 meters 

3. Loss Model = Cd Spray (Discharge Coefficient) 

4. Geometry = Spray Nozzle 

5. Exit Pressure = 0 barG (0 kPa(g)) 

6. Cd = 0.6 

7. Discharge Flow Area = 0.93 m2 

C. Check if the pipe and junction data is complete 

Turn on the “Show Object Status” button from the View menu to verify 
if all data is entered. If so, the third Checklist item will have a check 
mark. If not, the uncompleted pipes or junctions will have their number 
shown in red. If this happens, go back to the uncompleted pipes or 
junctions and enter the missing data. 

Step 4. Section the pipes 

Open the Section Pipes window from the Analysis menu. When the 
Section Pipes window is first opened, it will automatically search for the 
best (least average variance) option for one to five sections in the 
controlling pipe. The results will be displayed in the table at the top. 
Click OK to accept the displayed sectioning. 
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Step 5. Specify transient control 

Open the Transient Control window from the Analysis menu.  

1. Enter the Stop Time as 15 seconds. 

2. To minimize run time and output file size, select to Save Output to 
File Every 10 Time Steps. 

3. On the Junction Output tab ensure the pump speed for J21 (CWP-1) 
is being saved by checking the box next to it. 

4. Click the OK button. 

Step 6. Run the model 

The Checklist should now be complete and the model ready to run. Run 
the model by pressing the “Run Model” green arrow icon on the 
Workspace Toolbar, selecting “Run Model” in the Analysis menu, or 
pressing Ctrl+R on the keyboard. This will open the Solution Progress 
window. This window allows you to watch the progress of the Steady-
State and Transient Solvers. When complete, press the “Output” button 
at the bottom of the window.  

Step 7. Review results 

Clicking “Output” from the Solution Progress window, selecting the 
Output tab, or pressing Ctrl+U on the keyboard will take you to the 
Output window, which will display any warnings (if they exist). There 
should not be any warnings here after running this model. You will also 
see several tabs in the top third of the window displaying the Event 
Messages in the model. This tab only appears in the case where a 
conditional transient has been activated, such as a check valve or relief 
valve. 

Click on the Event Messages by Time tab. You should see a message 
stating that the internal check valve that we defined in pump J21 has 
closed. This tells us that reverse flow will occur in the pump in the actual 
system, but we prevented it with a check valve so that we could use the 
Standard Pump Curve rather than defining a Four Quadrant Data Set.  

The Graph Results window will be useful in evaluating the impact of this 
check valve. We will graph the static pressure and volumetric flowrate at 
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the pump suction and valve discharge as stacked graphs to see how these 
parameters vary with time. 

A. Graph the transient pressures at the pump 

1. Change to the Graph Results window from the Window menu, by 
clicking on the Graph Results tab, or by pressing Ctrl+G. 

2. Go to the Transient Pipe tab on the Graph Control tab and add Pipe 
P21 Outlet and Pipe P23 Inlet under “Graph These Pipes/Stations”. 
These locations represent the pump suction and valve discharge 
piping, respectively. 

3. Select the “Time Units” as seconds and ensure that the “Time 
Frame” is showing “All Times”. 

4. Add a second parameter to be graphed by clicking on the “Add” 
button, represented with the green “+” icon. Select “Pressure Static” 
as one parameter to be graphed and “Volumetric Flowrate Upstream” 
as the second parameter to be graphed. 

5. Move the Volumetric Flowrate Upstream to the secondary Y-axis by 
clicking the “Make Secondary Y-axis” button, which is the blue, 
right arrow icon. This parameter should now be indented. 

6. Set the units to “barG” for the static pressure and “m3/hr” as the 
volumetric flowrate. 

7. Click the Generate button. The resulting pressure and flow transients 
are shown in Figure 4.3.  

8. Click the Add Graph to List button from the Toolbar to save this 
graph to the Graph List Manager so that it can be regenerated later, 
and name it “Pump Suction & Valve Outlet Pressures and Flows”. 

In Figure 4.3 you can see that the pressure increases at the pump inlet 
and decreases at the valve outlet until a maximum pressure of 2.23 barG 
at the pump inlet and a minimum pressure of 1.08 barG at the valve 
outlet is reached. The pressures then begin to oscillate once the discharge 
valve becomes fully closed. 
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Figure 4.3 Pressure and volumetric flow rate transients using the 
standard pump curve data. 

B. Graph the pump speed decay 

You can graph certain junction properties for junctions in your model. To 
generate these graphs, the junction output data will need to be saved to 
file. You can specify which junctions you wish to save output data for by 
checking the box next to the junctions of interest in the Junction Output 
tab on the Transient Control window (Step 5: Specify transient control). 

To graph the pump speed decay, 

1. Return to the Graph Control tab on the Quick Access Panel. 

2. On the Transient Junction tab, add Pump J21. 

3. In the Parameter definition area, choose “Pump Speed” as the 
parameter to be graphed. 

4. Choose “Percent” in the Units column. 

5. Click the Generate button.  

The predicted pump speed is then shown in Figure 4.4 Click the Add 
Graph to List button from the Toolbar to save this graph to the Graph 
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List Manager so that it can be regenerated later, and name it “CWP-1 
Pump Speed Decay”. 

  

Figure 4.9 The pump speed decay is shown. The speed decays 
quickly at first, and then slows down after the check 
valve closes and the flow goes to zero 

Step 8. Create additional pump scenarios 

To check the validity of our results when using the standard pump curve 
with an internal check valve to perform the pump trip with inertia, we 
should now go back and run the model with the pumps specified using 
four quadrant data for comparison. We will create three children 
scenarios, one for the current pump configuration using the Standard 
Pump Curve, and two using a Four Quadrant Data Set. 

To do this, click the "Create Child" button on the Scenario Manager on 
the Quick Access Panel. Name the child “Standard Pump Curve”. A new 
scenario will appear below the Base Scenario in the scenario tree. Select 
the Base Scenario, create another child, and call it “Four Quadrant BEP”. 
We will later clone this scenario to create our third child scenario. 

The “Standard Pump Curve” Scenario will use the pump settings that 
were already defined, so no changes will be needed for this scenario.  
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Four Quadrant BEP 

Load the “Four Quadrant BEP” scenario by double-clicking the item in 
the Scenario Manager. Open the Pump Properties window for pump J21. 

1. Select the option for “Four Quadrant Curve”. (Figure 4.5) 

2. Uncheck the box to “Model Combined Check Valve and Pump” to 
disable the internal check valve. 

3. Uncheck the box to “Prevent Reverse Rotation”. 

4. Under the “Four Quadrant Curve” option click the “Specify 
Model…” button. 

5. AFT Impulse provides multiple pre-defined Four Quadrant Data sets 
which are characterized by specific speed. To choose a data set to 
use, we will first estimate the specific speed for the pump, which 
AFT Impulse will use to recommend a data set. To do this, click 
“Suggest a Data Set” under “Four Quadrant Data Set”. 

 

Figure 4.5 The Pump Model tab defined using the Four Quadrant 
Curve. Note that the Flow Directional Behavior section 
shows both forwards and reverse flow possibilities. 
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6. By Default AFT Impulse will select “Calculated from Standard 
Pump Curve”, which allows most of the data to be automatically 
populated from the Pump Properties window. In this case the pre-
defined data is accurate for the pump, so click Calculate. 

7. The specific speed in this case is estimated to be 2.50, and the 
suggested data set is therefore Ns = 2.48. Click “Select Suggested 
Data Set and Close”. The Ns = 2.48 data set will now be selected, 
and the dimensionalized curve will be displayed against the 
previously entered Standard Pump Curve. (Figure 4.6) 

8. Make sure that the Four Quadrant Curve Dimensional Reference 
Point is set to use the Best Efficiency Point for this scenario. We will 
select the Steady State Operating Point option later for the third 
scenario. Click OK on this window, then OK on the Pump Properties 
window to accept the changes. 

9. Repeat steps 1-8 for junction J31. The required input for this 
scenario is now complete. 

 

Figure 4.6 The Specify Four Quadrant Model window can be used 
to select and view options for the dimensionalized 
four quadrant data set. 
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Four Quadrant SSOP 

Clone the “Four Quadrant BEP” scenario by right-clicking the scenario 
name in the Scenario Manager and choosing “Clone Without Children”. 
Name this cloned scenario “Four Quadrant SSOP”. For pump J21 and 
J31, open the Pump Properties window and click the Specify Model… 
button under Four Quadrant Curve. Change the Four Quadrant Curve 
Dimensional Reference Point to Steady State Operating point, then click 
Ok on all open windows to accept the changes. The required input for 
this scenario is now complete.  

Step 9. Run the four quadrant scenarios 

Using the Scenario Manager load each of the four quadrant scenarios and 
run them, then go to the Graph Results tab. For each scenario generate 
the “Pump Suction & Valve Outlet Pressures and Flows” graph by 
double clicking the graph name in the Graph List Manager on the Quick 
Access Panel. The results for each of the scenarios can be seen in Figures 
4.7 and 4.8. In comparing the transient results for the two four quadrant 
scenarios, there are no major visible differences.  

Now navigate to the Output window for each of the scenarios, then select 
the Pump Summary tab in the top third section. Notice that for the Four 
Quadrant SSOP and standard pump curve scenarios, the steady state flow 
rate is about 2362 m3/hr, while the steady state flow rate for the BEP 
scenario is 2287 m3/hr. This difference in the Four Quadrant BEP 
scenario results from the fact that the pump is not operating exactly at 
BEP, as is the case for most pumps. 

While the difference in steady state and transient results for the two 
dimensional points is minor in this case, it may become more 
pronounced in other cases, and may lead to a trade-off between the 
accuracy of steady-state and transient data, especially if the pump 
operates further from BEP. Further details on this topic can be found in 
the main Help file for AFT Impulse. 

Comparison between the four quadrant graphs (Figure 4.7 & 4.8) and 
standard pump curve graph (Figure 4.3) reveals that while the results are 
similar, there is a visible difference of about 0.1 barG between the 
maximum and minimum points in the four quadrant scenario graphs and 
the standard pump curve scenario graph. These differences can be 
attributed to the small flow oscillations that are neglected in the standard 
pump curve scenario due to the internal check valve. 
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Figure 4.7 Pressure and volumetric flow rate transients using a 
Four Quadrant Curve dimensionalized at the BEP. 

  

Figure 4.8 Pressure and volumetric flow rate transients using a 
Four Quadrant Curve dimensionalized at the steady 
state operating point. 
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Step 10. Adjust the valve closure 

Now let’s consider the case where the valves at the discharge of the 
pumps cannot be closed in 5 seconds, but instead will close fully at 12 
seconds. In this case the reverse flow at the pump will be significant due 
to the delay in the valve closure profile. We will need to use a four 
quadrant data set to analyze the effects of the possible reverse flow and 
reverse rotation in the pump, since the Standard Pump Curve does not 
have sufficient data. We will use the default selection to use the pump 
BEP as the dimensional reference point, though using the steady state 
operating point as the reference point would produce similar results. 

In the Scenario Manager, select the Four Quadrant BEP scenario and 
create a child scenario named “12 Sec Valve Closure”. The new child 
scenario should now be active. Pumps J21 and J31 will already inherit 
the four quadrant model from the Four Quadrant BEP scenario, but we 
will need to adjust the valves. For Valves J22 and J32 open the Valve 
Properties window, then edit the Transient Data table found on the 
Transient tab to reflect the following closure profile. This scenario 
should now be complete. 

Time (sec) Cv 

0 10000
5 1000
12 0
30 0

Step 11. Specify transient control 

Since the valve closure takes a longer time, it will be useful to extend the 
run time. Open the Transient Control window from the Analysis menu 
and change the stop time to 30 seconds, then click OK. 

Step 12. Run the model 

The Checklist should now be complete and the model ready to run. 
Select “Run Model” in the Analysis menu. View the results by pressing 
“Graph Results” at the bottom of the Solution Progress window. 
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Step 13. Graph results 

Load the “Pump Suction & Valve Outlet Pressures and Flows” graph 
from the Graph List Manager, as seen in Figure 4.9. Note that as 
expected, a significant amount of reverse flow occurs at the pump from 
about 6-12 seconds, requiring data beyond the standard data which is 
typically used for forward flow with forward rotation at the pump. The 
resulting transient results show that the maximum pressures at the valve 
outlet and the pump suction have been reduced. 

The pump speed decay is shown in Figure 4.10. Note how the pump 
speed decreases at a faster rate than Figure 4.4. Additionally, at about 10 
seconds the pump begins to experience reverse rotation. This means that 
from 6 seconds to 10 seconds, the pump will have forward rotation with 
reverse flow, then from 10-12 seconds, the pump will experience reverse 
flow with reverse rotation. Both of these situations can be accounted for 
using the additional information provided by the Four Quadrant Curve. 

  

Figure 4.9 Predicted transient pump suction and discharge 
pressures and volumetric flowrates with a 12 second 
valve closure rate 
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Conclusion 

For the valve closure of 5 seconds a minimal amount of reverse flow was 
experienced at the pump. As a result, the standard pump curve with an 
internal check valve was sufficient, since use of four quadrant data to 
accurately model this reverse flow had only a small impact on the results. 
Additionally, the choices of using the BEP or Steady State Operating 
Point to dimensionalize the four quadrant data were shown to be very 
similar in the transient, but to have a 80 m3/hr difference in the steady 
state operating point. Changing the valve to close fully at 12 seconds 
resulted in significant reverse flow at the pump which required four 
quadrant data to be used. It was then found that increasing the valve 
closure time reduced pressures at the valve and pump. 

 

Figure 4.10 Pump Speed decay when the valves are modified to 
close fully at 12 seconds 
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Valve Closure With Force Sets Example 

This example examines a gravity drain system which transfers water 
from one tank to another through a filter and a valve in the connecting 
pipeline. It is necessary to determine the transient forces that occur 
when the valve is partially closed in order to analyze pipe stresses and 
loads on the pipe supports. 

Topics covered 

This example will cover the following topics: 

 Defining force sets 

 Graphing transient forces 

 Evaluating the effect of frictional losses on transient pipe forces 

 Use of Isometric Pipe Drawing Mode 

Required knowledge 

This example assumes that the user has some familiarity with AFT 
Impulse such as placing junctions, connecting pipes, entering pipe and 
junction properties, and entering transient data. Refer to the Valve 
Closure Example in Chapter 2 for more information on these topics. 
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Model Files 

This example uses the following files, which are installed in the 
Examples folder as part of the AFT Impulse installation: 

Valve Closure With Pipe Forces_Metric – Quick Start.imp 

Step 1. Start AFT Impulse 

From the Start Menu choose AFT Products and AFT Impulse. 

Step 2. Open model file 

For this example, we will be starting from a pre-built model file which 
has the first three checklist items completed to save time. From either the 
startup screen or the File menu, browse to the model file name shown 
above. The workspace should appear as shown in Figure 5.1. 

Isometric Drawing Mode 

The previous examples’ models were drawn using the default Pipe 
Drawing Mode, 2D Freeform. However, AFT Impulse has two additional 
available drawing modes, 2D Orthogonal and Isometric. Due to the 
nature of this model the Isometric mode was used to visually interpret the 
pipe layout and provide a better understanding of the system when 
analyzing calculated forces. 

For future reference when using this feature, the Isometric drawing mode 
can be turned on in the Arrange menu under Pipe Drawing Mode.  The 
isometric grid can also be turned on or off from the Arrange menu. When 
drawing segmented pipes such as P5, a red-dashed preview line will 
show how the pipe will be drawn on the isometric grid. As you are 
drawing a pipe, you can change the preview line by clicking any arrow 
key on your keyboard or scrolling the scroll wheel on your mouse. You 
can hold the “Alt” key while adjusting a pipe by the endpoint to add an 
additional segment. This can be used with the arrow key or mouse scroll 
wheel to change between different preview line options.  

For junctions such as J5, it may be useful to rotate the icon to be aligned 
with the isometric grid. This can be accomplished by right-clicking on 
the junction and choosing “Customize Icon”. 

 



Chapter 5   Valve Closure With Force Sets Example   91 

 

Figure 5.1 Layout of gravity drain system with isometric grid on. 

Note:  Pipe forces are typically calculated around pairs of pipe 
direction changes or at single points where the pipe is interrupted (for 
example, at an untied or non-pressure compensated expansion joint). 
These locations must be determined from piping drawings showing 
the physical arrangement of the piping, then related to the 
corresponding pipe in the AFT Impulse model along with the length 
along the pipe where the direction change or pipe interruption is 
located. Intermediate elevations are not necessary but are included 
here for later discussion. 

Step 3. Section the pipes 

 Open the Section Pipes window from the Analysis menu. When the 
Section Pipes window is first opened it will automatically search for the 
best (least average variance) option for one to five sections in the 
controlling pipe. The results will be displayed in the table at the top. 
Note that the default option under "Search Results" shows the number of 
sections in the controlling pipe is 1. 
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Note:  The closer the computing stations are to the desired force 
calculation location, the more accurate the force calculation will be. 

 Click OK to accept the results of using one section in the controlling 
pipe.  

Step 4. Specify transient control 

 Open the Transient Control window from the Analysis menu and enter 
a Stop Time of 10 seconds. 

 Select the Force Output tab and define a force set by clicking New, 
then entering the data as shown in Figure 5.2. Repeat this process for the 
second force set. 

  

Figure 5.2  Force sets defined in Transient Control. 

Since the force sets in this example calculate the force imbalance 
between adjacent pipe direction changes, the default force type of 
‘Difference’ is used. The ‘Point’ type would be used for calculating the 
force at a location where the fluid is leaving the system, such as an exit 
valve. The additional difference methods are available to analyze forces 
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across more than two pipes, or for cases where a user defined exit area 
would be useful, such as for forces across a nozzle.  

For a specified length to start node and length to end node, AFT Impulse 
will determine and display the nearest computing station number and 
actual length from inlet of the start and end pipe to the node within the 
pipe.  

Sectioning has produced one section each in pipes P2 and P3 for the 150 
m to 160 m force set and then 25 sections and six sections in pipes P4 
and P5, respectively for the 160 m to 300 m force set.  Section length is 5 
meters for each pipe. 

In our example, this sectioning conveniently results in computing 
stations at the locations where we want to calculate forces. Where 
computing stations do not coincide with the desired force calculation 
locations, some loss in accuracy will occur. By increasing the number of 
sections in the controlling pipe during sectioning, a greater number of 
computing stations will exist, thus reducing the distance to the desired 
force calculation locations, at the expense of longer run time. 

Note: AFT Impulse will set Pipe Station Output automatically to 
include only those stations required by the force set nodes up to five 
stations, or all stations if more than five stations are required. 

 Click the OK button to close Transient Control. 

Step 5. Run the model 

 Select Run Model in the Analysis menu. When completed the Solution 
Progress window will indicate that the run has completed. View the 
results in the Output window by clicking the Output button at the bottom 
of the Solution Progress window.  

Step 6. Graph pipe forces 

 Select the Forces tab from the Graph Parameters section on the Quick 
Access Panel. The force sets defined in Transient Control will appear as 
available forces to graph. 

Check the box next to the "150 m to 160 m" force set. This corresponds 
to the elevation change between the branch junctions of 10 meters and 0 
meters specified from pipes P2 and P3. Also check the box next to the 
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“160 m to 300 m” force set, which corresponds to the force over the 
closing valve. Click Generate and the following force vs time graph is 
displayed (Figure 5.3). 

 

Figure 5.3 Unbalanced Force vs. Time for force set "150 m to 160 
m" with friction. 

Note that at time 0, which represents the initial, steady state results, there 
is no force imbalance. This is the expected results for a system at steady 
state. 

Some traditional methods of analyzing force sets will not have this same 
result, since they do not include the effects of friction or momentum in 
their force balances. If the graph from Figure 5.3 is created with friction 
and momentum ignored, the steady state values are actually calculated as 
approximately -4790 N and -11940 N. Due to this effect, AFT Impulse 
will always include both friction and momentum by default when 
graphing force sets. 

In summary, there are two important points to be observed here: 
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1. AFT Impulse calculates transient, or time varying hydraulic forces. 
This does not include constant loads from fluid, piping and 
component weight. A comprehensive analysis of pipe loading must 
separately include these items. 

2. In some cases, ignoring friction and momentum force balance 
components will result in force imbalances that do not exist in 
reality, since the frictional forces on the pipe exactly counterbalance 
the force calculated from the pressure differential at the selected 
locations. 

Final notes 

An AFT Impulse model does not contain directional data with regard to 
the forces, it knows only pipe length and elevation. Since forces are 
vectors with both magnitude and direction, the user must identify the 
direction of the calculated forces using data in the pipe arrangement 
drawing that defines the geometry of the pipe routing. 

Analysis summary 

In this example it can be seen that AFT Impulse is capable of predicting 
transient hydraulic forces which occur in the system due to surge. 
Including frictional results is important to avoid force imbalance in the 
steady state. With the data that is obtained from the force sets in AFT 
Impulse the engineer can then export this information to CAESAR II, 
ROHR2, TRIFLEX or other pipe stress analysis software for further 
analysis on the impact of forces on the structural support. 
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C H A P T E R  6  

AFT Impulse Add-on Modules Examples 

This chapter covers the Settling Slurry (SSL) and Pulsation Frequency 
Analysis (PFA) modules. The user can only perform these examples if 
access to the relevant modules is available. 

Topics covered 

These examples will cover the following topics: 

 Defining settling slurry properties 

 Reviewing slurry output 

 "Ringing" systems to find natural acoustic frequencies 

 Finding system excitation frequencies 

 Calculating pressure response of system at ‘worst case’ PD speeds 

Required knowledge 

These examples assume that the user has some familiarity with AFT 
Impulse such as placing junctions, connecting pipes, and entering pipe 
and junction properties. Refer to Valve Closure Example in Chapter 2 for 
more information on these topics.  
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Model files 

These examples use the following files, which are installed in the 
Examples folder as part of the AFT Impulse installation: 

 Sand Transfer to Two Locations – SSL_Metric.imp 
 PD Pulsation Study – PFA_Metric.imp 

SSL problem statement 

Sand is being transferred from a quarry sand pit to receiving deposits in 
two different locations. There are two valves that control the flow to each 
of these deposits by changing their opening position (modeled as Cv).  
The ratio of the mixture velocity to the velocity at which the sand will 
settle out of the liquid and form a stationary bed on the bottom of the 
pipe (Vsm) must be kept above 1.2 to avoid potentially plugging the 
pipe. Determine if the pipe size and velocity ratio is acceptable during 
the transient where one valve starts to close while the other opens 
further. 

SSL Step 1. Start AFT Impulse 

From the Start menu, choose AFT Products and AFT Impulse. On the 
Startup window, select to activate the SSL module. If AFT Impulse is 
already running, choose Activate Modules from the Tools menu and 
select the SSL module. 

SSL Step 2. Specify system properties 

1. Open the System Properties window by selecting System Properties 
in the Analysis menu. 

2. Select Basic Water Slurry Input at the upper right (this should be the 
default selection). See Figure 6.1 

3. Select “Detailed” under “Slurry Calculation Method”. 

4. In the Solids Specifications area select the “User Specified Solids 
Added” button. 

5. Select the calculated M and Vt/Vts factor of 0.55. 
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6. Enter a solids density of 2.65 S.G. water, a d50 of 0.07 cm, a d85 of 
0.1 cm, and a Bulk Modulus of 16,000 MPa. 

7. Enter a temperature for water of 21 deg. C. 

8. Set the Concentration Type to “Volume Fraction”, and for the 
Amount Solids Added field, specify 20%. 

9. Select the Settling Slurry – Wilson, Addie, Clift model. 

10. Select OK. 

 

Figure 6.1 Data entry for sand slurry properties 

SSL Step 3. Build the model 

A. Place the pipes and junctions 

At this point, the first two items are completed on the Checklist. The next 
Checklist item is to “Define All Pipes and Junctions”. In the Workspace 
window, assemble the model as shown in Figure 6.2. 
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Figure 6.2 Layout of pipe system for Sand Transfer to Two 
Locations example 

B. Enter the pipe data 

The system is in place, but now you need to enter the input data for the 
pipes and junctions. 

All pipes are Steel - ANSI, with standard roughness, thick-walled 
anchored upstream and the following data: 

Pipe Length 
(meters) 

Size Type 

P1 3 10 inch Schedule 40 

P2 122 10 inch Schedule 40 

P3 1.5 10 inch Schedule 40 

P4 26 10 inch Schedule 40 

P5 122 10 inch Schedule 40 

P13 1.5 10 inch Schedule 40 

P14 30.5 10 inch Schedule 40 

P15 213 10 inch Schedule 40 
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C. Enter the junction data 

J1 - Reservoir 

1. Name = Sand Pit 

2. Liquid Surface Elevation = 0 meters 

3. Liquid Surface Pressure = 0 barG (0 kPa (g)) 

J3 - Branch 

Elevation = 1.2 meters 

J5 - Branch 

Elevation = 6 meters 

J15 - Branch 

Elevation = 9 meters 

J6 - Reservoir 

1. Name = Deposit #1 

2. Liquid Surface Elevation = 6 meters 

3. Liquid Surface Pressure = 0 barG (0 kPa (g)) 

J16 - Reservoir 

1. Name = Deposit #2 

2. Liquid Surface Elevation = 9 meters 

3. Liquid Surface Pressure = 0 barG (0 kPa (g)) 

J2 - Pump 

1. Name = Main Slurry Pump 

2. Elevation = 1.2 meters  

3. Choose the Centrifugal (Rotodynamic) model button 

4. In the “Reverse Flow” area choose “Never”, since the discharge 
valves are designed to prevent reverse flow through the pump. 
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5. Click the “Enter Curve Data” button and enter the following data 
(Figure 6.3). Ensure that Power is selected in the Efficiency/Power 
area): 

Q (m3/hr) H (meters) Power (kW) 
0 152 764 

908 145 820 
1590 122 894 
2044 91 1006 

6. In the Curve Fitting area, select the All button then click the 
Generate Curve Fit now button. Then click OK 

 

Figure 6.3 Pump J2 performance data 
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J4 - Valve 

1. Name = Valve to Deposit #1 

2. Elevation = 1.2 meters 

3. Cv = 500 

4. Click the Transient tab, select “Time” under “Initiation of 
Transient”, then enter the transient data as follows: 

Time (sec) Cv 
0 500 
1 500 
6 300 
10 300 

J14 - Valve 

5. Name = Valve to Deposit #2 

6. Elevation = 1.2 meters 

7. Cv = 400 

8. Click the Transient tab, select “Time” under “Initiation of 
Transient”, then enter the transient data as follows: 

Time (sec) Cv 
0 400 
5 500 
10 500 

 

D. Check if the pipe and junction data is complete 

Turn on “Show Object Status” from the View menu to verify that all the 
necessary data is entered. If so, the “Define All Pipes and Junctions” 
Checklist item on the Quick Access Panel will have a check mark. If not, 
the uncompleted pipes or junctions will have their number shown in red. 
If this happens, go back to the uncompleted pipes or junctions and enter 
the missing data. You can also open the List Undefined Objects window 
from the View menu to see what data is missing. 
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SSL Step 4. Section the pipes 

Open the Section Pipes window from the Analysis menu. When the 
Section Pipes window is first opened, it will automatically search for the 
best (least average variance) option for one to five sections in the 
controlling pipe. The results will be displayed in the table at the top. 
Click OK to accept the displayed sectioning. 

SSL Step 5. Specify transient control 

Open the Transient Control window from the Analysis menu. Enter the 
Stop Time as 10 seconds, then click the OK button. 

SSL Step 6. Run the model 

The Checklist should now be complete and the model ready to run. 
Select “Run Model” in the Analysis menu. This will open the Solution 
Progress window. This window allows you to watch the progress of the 
Steady-State and Transient Solvers. When complete, press the “Output” 
button at the bottom of the window to view the results.  

SSL Step 7. Review results 

A. Check the Transient Max/Min in the Output 

Clicking “Output” on the Solution Progress window will take you to the 
Output window (Figure 6.4). As a design objective, the system is 
required to have at minimum a Vsm of 1.2 to avoid the potential of the 
sand falling out of the slurry and plugging the pipe. 

 By inspecting the Min Vsm column in the Transient Max/Min tab, it can 
be seen that the minimum Vsm drops below this value in pipe P4. 

Note: A Design Alert could be defined in the Tools menu to 
automatically evaluate if this design objective is met, and issue a 
warning if the condition is not satisfied. A predefined Design Alert for 
this model can be seen by opening the Sand Transfer to Two 
Locations – SSL_Metric.imp model file which is installed in the 
Examples folder in the AFT Impulse 7 folder. 
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There are several factors that may be contributing to this. Pipe P4 is 
sloped upward which increases the settling velocity and decreases the 
velocity ratio of concern. Also, all Pipes in the model have a 10 inch 
diameter. However, the main pipes P1 and P2 are carrying much more 
flow than the others so the pressure drop in these is greater. This can be 
reduced by increasing the size. The size cannot be increased too much 
because this would reduce the velocity ratio below the 1.2 minimum. 

 

Figure 6.4 Design Objective violation in pipe P4 station 17 

Return to the Workspace and change Pipes P1 and P2 to have a 14 inch 
diameter. Since the size of the pipes was changed, the pipes need to be 
re-sectioned by opening the Section Pipes window. Click OK to accept 
the results. Then open Transient Control and click OK.  

Rerun the model and view the Output. There should not be any warnings 
now that the pipes were changed. The Graph Results window will be 
more useful in understanding the results. 

B. Graph the velocity ratio and pressures to Deposit #1 

You will use stacked graphs to simultaneously view the maximum and 
minimum velocity ratio and pressures in the system during the transient. 

1. Change to the Graph Results window from the Window menu, by 
clicking on the Graph Results tab, or by pressing Ctrl+G on the 
keyboard. 
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2. Open the Profile tab on the Graph Control tab. 

3. For the Pipes section, select “Plot Single Path”. 

4. Select pipes P1, P2, P3, P4 and P5 (Figure 6.5). These represent the 
flow path to Deposit #1. 

 

Figure 6.5 Data selection to view the maximum and minimum 
values of the velocity ratio and static pressure along 
the flow path to Deposit #1. 

5. Choose “meters” as the Length Units. 

6. Because you are not animating these values in this example, ensure 
that “None” is selected next to Animate Using. 

7. In the Parameters definition area, ensure that there are two 
parameters by selecting the green “+” icon to add a parameter to 
graph. Choose “Velocity Ratio (Vm/Vsm)” for one parameter and 
“Pressure Static” for the other. 

8. Specify “barG” as the Units for the Pressure Static parameter. 
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9. Check the boxes under the “Mx” and “Mn” columns for both 
parameters to ensure that the maximum and minimum values are 
being displayed for both graphs. 

10. Click the Generate button. The resulting graphs are shown in Figure 
6.6. 

Recall that, before modifying pipes P1 and P2 to 14 inch pipe, the 
minimum velocity ratio was below the design alert limit of 1.2 for a 
portion of the path. Now with 14 inch pipe, the minimum is above the 
1.2 limit along the entire path. You can also check the same parameters 
for the flow path leading to Deposit #2. 

  

Figure 6.6 Maximum and minimum velocity ratio and static 
pressure values in the flow path to Deposit #1. Note 
that the velocity ratio is above the minimum Design 
Alert of 1.2 at all locations. 
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C. Graph the velocity ratio over time 

A time comparison of the velocity ratio in the critical pipes along the two 
flow paths is important to consider. To graph this profile, complete the 
following steps: 

1. Return to the Graph Control tab on the Quick Access Panel. 

2. On the Transient Pipe tab, select Pipes P4 Inlet and P14 Inlet and add 
them to the pipe stations to graph (Figure 6.7). These are the two 
sloped pipes which have the lowest velocity ratio 

3. Specify the Time Units as seconds 

4. Specify “All Times” as the Time Frame 

5. In the Parameters definition area, choose Velocity Ratio (Vm/Vsm)  

6. Click the Generate button 

 

Figure 6.7 Data selection to view the velocity ratio over time 



Chapter 6   AFT Impulse Add-on Modules Examples   109 

The resulting graph is shown in Figure 6.8. This shows that, as Valve J4 
closes and Valve J14 opens, the velocity ratios in the pipe immediately 
downstream change but stay in the acceptable range. 

 

Figure 6.8 The velocity ratio in the sloped pipes as the valves 
change position 

SSL analysis summary 

A slurry of sand and water flowing to two deposits was modeled. The 
velocity ratio was examined to ensure a minimum value was maintained 
throughout the transient to avoid the danger of the sand settling out of the 
slurry and plugging the pipe. The analysis showed that the initial pipe 
diameter selected was not adequate. A larger size was selected to meet 
the system requirements over the simulation time. 
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PFA problem statement 

A system with positive displacement pumps has a known pulsation issue 
in a section of piping with a closed valve. This issue is caused by the 
system’s natural frequency resonating with certain PD pump frequencies, 
resulting in severe pressure oscillations at the closed valve. A forcing 
function will be placed on the PD Pump to discover the natural acoustic 
frequencies, which will then be used to find the worst-case scenarios for 
the system. 

PFA Step 1. Start AFT Impulse 

From the Start Menu choose AFT Products and AFT Impulse. From the 
Startup window under the "Activate Modules" section in the middle 
panel, select the PFA (Pulsation Frequency Analysis) option to activate 
the PFA module. If Impulse is already running, choose Activate Modules 
from the Tools menu. 

PFA Step 2. Specify system properties 

1. Open the System Properties window by selecting System Properties in 
the Analysis menu. 

2. On the Fluid Data tab, select User Specified Fluid 

3. Enter 0.92 g/cm3 in the fluid density box  

4. Enter 0.95 cP in the fluid dynamic viscosity box 

5. Enter 9653 bar in the fluid bulk modulus box 

6. Click OK 

PFA Step 3. Build the model 

A. Place the pipes and junctions 

At this point, the first two items are completed on the Checklist. The next 
Checklist item is to "Define Pipes and Junctions". In the Workspace 
window, assemble the model as shown in Figure 6.9. 
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Figure 6.9 Layout of PD Plunger Pulsation Study example 

B. Enter the pipe data 

The input data for the pipes and junctions now needs to be entered. 
Double-click on each pipe to open the properties window and enter the 
following data (or use the Global Pipe Editing window). 

All pipes use user-specified material with the following inputs. 
Throughout the model a User Specified Wavespeed of 915 m/s is used, 
and the roughness is 0.00152 cm. 

Pipe No. Inner Diameter 
(cm) 

Length 
(m) 

1 30.5 1 

2 30.5 1 

3 5.5 12 

4 5.5 17 

5 8.3 10 

6 4.3 6 

7 8.3 15 

8 4.3 1 

9 8.3 9 
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C. Enter the junction data 

Double-click each junction and enter the following data in the Properties 
window (or use the Global Junction Editing window). 

J1 and J2 – Assigned Flow 

For the sake of simplicity, assigned flow junctions are being used to 
represent the PD pumps with the information listed below. The Pulsation 
Setup window will be used later to place the necessary transient data in 
the assigned flow junction for the pump being analyzed. 

1. Elevation = 0 meters 

2. Volumetric Flow Rate = 8 m3/hr 

J3 and J4 - Area Change 

1. Elevation = 0 meters 

2. Type = Abrupt Transition (K factor is automatically calculated)  

J8 and J9 - Area Change  

1. Elevation = 0 meters 

2. Type = Conical Transition (K factor automatically calculated) 

3. Angle = 90 degrees 

J5 and J6 - Tees  

1. Elevation = 0 meters 

2. Loss Model = Simple (no loss) 

 J10 - Spray Nozzle 

1. Elevation = 0 meters 

2. Loss Model = Cd Spray (Discharge Coefficient) 

3. Geometry = Spray Nozzle 

4. Exit Properties = Pressure 

5. Exit Pressure = 1.01 bar 

6. Cd (Discharge Coefficient) = 1 

7. Discharge Flow Area = 0.148 cm2 
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J7 - Dead End 

Elevation = 0 meters 

D. Check if the pipe and junction data is complete 

Turn on Show Object Status from the View menu to verify that all the 
necessary data is entered. If so, the “Define Pipes and Junctions” 
Checklist item on the Quick Access Panel will have a check mark. If not, 
the incomplete pipes or junctions will have their number shown in red. If 
this happens, go back to the incomplete pipes or junctions and enter the 
missing data. You can also open the List Undefined Objects window 
from the View menu to see what data is missing. 

PFA Step 4. Define pulsation setup properties 

Defining the initial pulse or “ring” is an important step in determining 
the natural frequencies that different stations in the model will respond 
to. This is the numerical equivalent of hitting the system with a hammer 
to see how it responds at different frequencies. This first step does not 
represent a realistic operating condition, but rather reveals what 
frequencies of real-world operation may present operational problems. 

Open the Pulsation Setup window from the Analysis menu. The 
Pulsation Setup window is the main interface for specifying input 
regarding the initial pulse and other information about the pulsation 
source. There are two tabs on the Pulsation Setup window directly 
associated with the PFA module: the Pulsation Setup tab and the PD 
Pump Settings tab. The PD Pump Settings tab only requires input if the 
source of pulsation is a positive displacement pump. Because the source 
of pulsation in our model is a positive displacement pump, we will need 
to complete the input on both of these tabs as shown below: 

1. Define the Pulse Properties on the Pulsation Setup tab (see Figure 6.10 
for all input on the Pulsation Setup tab in the Pulsation Setup window) 

a. Applied At = J2 (Assigned Flow) 

b. Start Time = 0 seconds 

2. Check the box next to Use Variable Pipe Resistance 

3. Verify that the Magnitude is being calculated automatically. This is 
equal to twice the steady-state flow. In this case, the Peak is 16 
m3/hr.  
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4. Define the Pulsation Source 

a. Select Positive Displacement (PD) Pump 

b. Enter 3 for the number of heads 

c. Enter 250 rpm for the pump speed 

d. Select 15% for the speed buffer 

5. Verify that the Low-Pass Filtering defaults are applied 

a. Filter Type = Chebyshev 

b. Order = 10 

c. Ripples Allowed = 1 dB 

6. Verify that the Cutoff Frequency is calculated automatically using 
the PD Pump Characteristics. In this example, the Cutoff Frequency 
is calculated to be 86.25 Hz. 

  

Figure 6.10 Pulsation Setup window with input 

7. Now that all required input has been entered in the Pulsation Setup 
tab, enter the following information on the PD Pump Settings tab 
(see Figure 6.11). 

a. Minimum Pump Speed = 125 RPM 
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b. Bore Diameter = 7.6 cm

c. Stroke Length = 5.2 cm

d. Rod Length = 25.4 cm

e. Clearance = 70 Percent (%)

f. Suction Pressure = 4.5 bar

g. Discharge Pressure = 415 bar

h. Phase Lag = 0 degrees

8. Click OK to keep the changes and close the Pulsation Setup window.

Figure 6.11 PD Pump Settings tab with input 

PFA Step 5. Section the pipes 

Open the Section Pipes window from the Analysis menu. While using 
the AFT Impulse PFA module, the pulsation setup needs to be completed 
prior to sectioning the pipes in the model. To section the model’s pipes 
for the simulation, complete the following: 

1. Select the significant pipes that should consider error. In our
example, we will consider the error in all modeled pipes, except for
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pipe P8. You can see that this pipe has been excluded in Figure 6.12. 
This is because this pipe represents a meter in the physical system 
and is not an actual pipe. Ensure that the box next to each pipe is 
selected under Consider Variances, except for pipe P8. 

 

Figure 6.12 Section Pipes window excluding the variance at P8 

2. Select 1 section in the controlling pipe by clicking on 1 section in the 
table under Search Results. 

3. Select Show Pulsation Graphs located at the bottom left of the 
Section Pipes window. A graph of the pulse will appear (see Figure 
6.13). You can also view graphs for the FFT of the Pulse, the LPF of 
the Pulse FFT, and the FFT of the LPF in the Graph Parameter graph 
that appears. After you are done viewing these graphs, click Close. 

4. Click OK to close the Section Pipes window, and click OK for the 
pop-up window notifying you that the forcing function has been 
placed on J2 (the junction that was selected in the Pulsation Setup 
window) as transient data. 

5. Open J2 to verify that the numerical “ring” has been applied to the 
transient (see Figure 6.14 for the transient input). This transient is a 
brief jump in flow rate at junction J2. 

PFA Step 6. Run the model 

The Checklist should now be complete and the model ready to run. 
Select Run Model in the Analysis menu. This will open the Solution 
Progress window. This window allows you to watch the progress of the 
Steady-State and Transient Solvers. When complete, click the Graph 
Results button at the bottom of the Solution Progress window.  
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Figure 6.13 Graphs of Pulse and LPF of Pulse in this example 
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Figure 6.14 Assigned Flow Properties with forcing function 
applied to J2. Choosing “Show Graph…” under the 
data shows this in graphical form. 

PFA Step 7. Review results 

Find excitation frequencies to study 

1. On the Graph Control tab on the Quick Access Panel, click the 
Frequency tab to begin generating an Excitation Frequency Analysis 
graph. 

2. We need to determine which frequencies excite the pump speeds 
within the pump speed range we have specified. For the purposes of 
this example, we will graph the Excitation Frequency graph for 10 
different pipe stations. Note that it is the engineer's responsibility to 
evaluate all pipe stations that could be excited by various frequencies 
and to perform the necessary analysis. 
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3. On the Graph Results tab, select the Frequency tab and select the
inlet and outlet stations for the following pipes: 1, 2, 3, 5, and 6.

4. Click Generate. The resulting graph (shown in Figure 6.15)
represents the frequencies that are excited by the pulse defined in the
Pulsation Setup window .

From the graph in Figure 6.15, we see that there are several frequencies 
that produce a large pressure magnitude.  Points on the plot with a large 
response magnitude are easily identified by finding local maxima on the 
graph. These maxima are the acoustic frequencies that will most excite 
the system at the selected stations. 

Note that the graph in Figure 6.15 can quickly be changed to display the 
magnitude on a logarithmic scale in order to allow for easier viewing of 
the magnitude behavior changes with a changing frequency. To view the 
Excitation Frequency Analysis graph with the magnitude displayed on a 
logarithmic scale, generate the frequency graph as discussed above. 
Right-click on either axis and select the box next to Logarithmic. 

Figure 6.15 Excitation Frequency Analysis graph   
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 Evaluate excitation frequencies 

The identified frequencies can now be evaluated to determine pump 
speeds that would cause them to be excited. These excitation frequencies 
need to be evaluated to examine potentially problematic pump speeds. 
Follow the steps below to select and evaluate the excitation frequencies. 

1. Left-click near the frequency of around 33 Hz and drag the mouse
over the peak on the graph near this frequency. This will highlight
and flag the local maximum. Figure 6.16 shows the frequency graph
after the dialog flag appears.

2. Right-click on the dialog flag that appears on the peak of this
frequency

3. Select "Evaluate Excitation Frequency" to add this frequency to the
Pump RPM Evaluation panel, which is labeled with "Excitation
Frequencies and Pump Speeds (RPM)". Repeat steps 1 through 3 for
the local maxima at the frequencies of 29.17 Hz and 6.79 Hz. The
panel should now appear as shown in Figure 6.17.

Figure 6.16 Excitation Frequency Analysis with Dialog Flag. Right-
clicking on the Dialog Flag provides the option to 
Evaluate Excitation Frequency. 
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Figure 6.17 Pump RPM Evaluation Panel with Excitation 
Frequencies and their Harmonic Multiples Displayed 
in the bottom of the Quick Access Panel. 

When choosing low or high frequencies on the graph, it is possible to 
select a frequency which is excited in the system but does not have a 
pump speed within the minimum and maximum pump speeds for the 
analysis. The minimum pump speed is defined directly in the PD Pump 
Settings in the Pulsation Setup window, while the maximum is calculated 
using the Pump Speed and Speed Buffer defined under “Pulsation 
Source” in Pulsation Setup. For example, try selecting the largest 
maxima, which occurs at 6.1 Hz. The message in Figure 6.18 appears.  

 

Figure 6.18 Message Indicating No Excitation Pump Speeds 
Between the Min and Max Pump Speeds Exist 

Determine the pressure response of the system at excited 
frequencies 

In the Pump RPM Evaluation panel, corresponding pump speeds can be 
selected for study. At these speeds, the pressure response is important to 
characterize. By default, all speeds in the Pump RPM Evaluation panel 
are pre-selected and must be clicked to be turned off. Child Pump Speed 
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scenarios can then be created that will have the Flow vs. Time profile at 
the selected speed (RPM) that will excite the evaluated frequencies. 

We will create child scenarios for all three Excitation Frequencies in the 
Pump RPM Evaluation panel. To do this, ensure that the pump speeds of 
135.8, 194.5, and 222.1 RPM are selected (not italicized). 

1. Click “Create Scenarios Based On Selected Pump Speeds…” 

2. A dialog box will appear stating that three scenarios will be created 
based on the selected speeds in the Pump RPM Evaluation panel. 
Click Yes to continue creating the child scenarios. 

3. Double-click on the  "135.8 RPM (6.8 Hz)" child scenario to load it 
as the current scenario. 

The scenario will now have different transient information in J2, 
modeling the pump performance at 135.8 RPM. Go to the Workspace 
and open the Properties window for J2. On the Transient tab click Show 
Graph under the Transient Data table to verify the Pump Flow Forcing 
Function has been applied, as shown in Figure 6.19.  

 

Figure 6.19 New Assigned Flow transient representing the PD 
Pump operating at 135.8 RPM  
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Run the "135.8 RPM (6.8 Hz)" scenario to see the pressure response. 
Often, the most noticeable pressure response will occur in stagnant 
branched lines.  For the purposes of this example, we will evaluate the 
pressure responses through pipe P6. However, engineers must ensure that 
all pipes that could experience significant pressure responses are 
analyzed. 

1. To create a pressure profile graph in pipe P6, go to the Graph Results 
tab and in the Graph List Manager, select Profile for the graph type. 

2. Check the box for Pipe P6. 

3. Select Pressure Stagnation for the Parameter. 

4. Use bar for the units. 

5. Click Generate. 

6. Right-click on the y-axis to adjust the y-axis scale by unchecking the 
Auto Scale box, then changing the Minimum to 240 and the Major 
Val to 20. 

Figure 6.20 shows the profile plot for Pipe P6 at a pump speed of 135.8 
RPM.    

  

Figure 6.20 Max/Min Pressure Profile of Pipe P6 for 135.8 RPM 
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The pressure vs. time can be displayed for any pipe station. Plot the 
pressure vs. time for pipe P6 by following the directions below: 

1. In the Quick Access Panel, select Transient Pipe for the graph type.

2. Add the outlet and inlet of Pipe P6 to the “Graph These
Pipes/Stations:” list.

3. Select Pressure Stagnation for the Parameter.

4. Use psia for the units.

5. Set the Time Frame to User Specified with a Start Time of 0 and a
Stop Time of 2 seconds.

6. Click Generate (see Figure 6.21)

Figure 6.21 Pressure Oscillations at Inlet and Outlet of Pipe P6 for 
135.8 RPM 

After looking at these graphs, return to the Output tab and make note of 
the message in red at the bottom right of the screen that states that 
Warnings Exist. These warnings are reported in the upper third of the 
output window and warn the user of potential issues with the model. 
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The PFA module will check the Peak-to-Peak pressures and compare 
them to the permissible values in the API-674 standard. If the limits from 
the standard are violated in the model, a warning will appear like in this 
case, where the Peak-to-Peak pressures exceeded the allowable limits. 
Additionally, the vapor pressure margin is checked. This is the margin 
between the minimum pressure and 10% over the vapor pressure, per the 
API-674 standard. More information on this can be seen on the Applied 
Standards and Pulsation Summary tabs. 

For the purposes of this example, we will repeat these steps for the pump 
speed of 222.1 RPM because analysis was performed beforehand to 
determine that this pump speed causes the largest pressure oscillations.  
We will show these graphs here. When performing an analysis on your 
system, all pump speeds that excite the system should be evaluated. 

Figure 6.22 shows the Max/Min Pressure Profile for P6 for the pump 
speed of 222.1 RPM.  

Figure 6.22 Max/Min Pressure Profile of Pipe P6 for 222.1 RPM 

Notice the large difference between the maximum and minimum 
pressures at the end of the pipe, located next to the Dead End junction. 



126   AFT Impulse 7 Quick Start Guide 

The large pressure oscillation in Pipe P6 can be seen in Figure 6.23. It is 
important to note that the inlet of Pipe P6 does not exhibit as large of a 
response as the outlet does. This oscillation, if allowed to continue, can 
lead to mechanical and support fatigue and thus failure. It should be 
noted in the Ouput that this scenario also violates the API-674 standard. 

Figure 6.23 Pressure Oscillations at Inlet and Outlet of Pipe P6 for 
222.1 RPM 

PFA analysis summary 

AFT Impulse and the PFA (Pulsation Frequency Analysis) module were 
used to discover the problematic pump frequencies occurring in a system 
with a known pulsation issue. The software was used to identify these 
frequencies, and after the frequencies were identified, a corresponding 
pump operating speed was examined to find the pressure response of the 
system. Using graphing features, the pressure response was plotted and 
studied. The steps followed lead to the successful pulsation analysis of 
the system. 
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Other AFT Impulse Capabilities 

This Quick Start Guide necessarily omitted coverage of a number of 
AFT Impulse capabilities. This chapter briefly describes some of the 
important capabilities not covered. 

Microsoft Excel™ data integration 

AFT Impulse now includes enhanced Excel importing and robust Excel 
exporting. An Excel spreadsheet can be used to vary selected input 
parameters in multiple scenarios. Selected output can also be exported to 
specified Excel sheets and cells.  

Integration with other software and data standards 

AFT Impulse includes a number of importing and exporting capabilities. 
Piping layouts and dimensional data can be imported from GIS 
Shapefiles (SHP) to build a model. CAESAR II Neutral Files (CII) can 
be imported into AFT Impulse and EPANET Files (INP) can be both 
imported and exported. Additionally, force files can be exported for use 
in CAESAR II, TRIFLEX, and ROHR2. 

Piping Component Files (PCF) from AutoCAD Plant 3D, SmartPlant, 
PDS, CADWorx, and other software can be imported into AFT Impulse. 
These options are all accessed from the File Menu. 
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Transient cavitation and liquid column separation  

AFT Impulse offers the Discrete Gas Cavity model (DGCM) and the 
Discrete Vapor Cavity model (DVCM) for modeling transient cavitation 
(also known as liquid column separation). These models calculate vapor 
volume size over time and account for pressure spikes when cavities 
collapse. Vapor volume can be plotted in the Graph Results window. 

Four quadrant pump modeling 

When pumps can flow or rotate backwards, four quadrant modeling is 
needed. AFT Impulse offers four quadrant models using the popular 
Suter method. Twenty-one sets of four quadrant data are provided. 

Positive displacement pumps 

AFT Impulse can model positive displacement pumps. Typically this is 
done by modeling the pump as a known flowrate over time. Complicated 
periodic flowrates from multiple pistons and/or multiple out of phase 
pumps can also be modeled. 

Pumps with viscosity corrections 

When the liquid is sufficiently viscous, centrifugal pump performance 
will be degraded. AFT Impulse models corrections to manufacturer 
performance curves during steady and transient flow. 

Pumps with variable speed controllers 

Pumps with speed controllers can be modeled during steady and transient 
flow. Transients caused by flow or pressure control level changes with 
time can be modeled. 

Pumps as turbines (PAT) 

Pumps being operated as turbines can be modeled during steady and 
transient flow using the Pump as Turbine model in the Pump junction. 
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Variable density and viscosity modeling 

Systems that have variable density and viscosity can be modeled. The 
density and viscosity can be assigned on a pipe by pipe base. 

Vacuum breaker valves 

Vacuum breaker valves (also known as air inlet valves) are used to 
protect against low pressure conditions. AFT Impulse can model vacuum 
breaker valves, including different inflow and outflow geometries. 

Surge tanks 

Surge tanks are a surge suppression device used in low pressure systems 
with non-volatile fluids. AFT Impulse can model surge tanks, including 
transient surface pressure for enclosed tanks. 

Relief valves 

The Relief Valve junction allows flexibility in modeling relief valve 
behavior by defining combinations of opening and closing profiles based 
on different parameters, such as time or pressure. In addition to set 
pressure, users can define a blowdown pressure for relief valves that 
close at pressures lower than the set pressure. Relief valves can have 
constant backpressure acting on the valve stem (hydraulically balanced) 
so the set points can be defined as absolute upstream pressures. 
Alternatively, the set points can be entered as a pressure difference 
across the valve. For valves with pressure profiles, the Cv profile for the 
valve can be entered by the user or automatically set according to the 
valve set points. In addition, users can define opening and closing rate 
limits for valves with pressure profiles. 

Flow and pressure control valve transients 

AFT Impulse can model flow and pressure control valves. AFT Impulse 
accounts for control valves which lose and regain control during the 
transient. Transients caused by changes in flow or pressure control 
setpoints can also be modeled. 
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Non-Newtonian fluid modeling 

AFT Impulse can model steady and transient flow of non-Newtonian 
fluids which behave as Power Law, Bingham Plastic or Homogeneous 
Scale-up viscosity models. 

Pulp and paper modeling 

AFT Impulse can model steady and transient flow of pulp and paper 
stock using the Duffy method or Brecht & Heller method. 

Infinite pipe boundaries 

Infinite pipe boundaries can be very useful for long, non-reflecting pipes. 
Model run times can be significantly reduced with these elements. Both 
Assigned Flow and Assigned Pressure junctions can be specified to 
behave as infinite pipe boundaries during transients. 

Repeat transient feature for periodic transient behavior 

For elements which have periodic behavior (such as positive 
displacement pumps), one cycle of data can be entered and then specified 
to repeat once the cycle is finished. 

Intermediate elevations for pipes 

Typically, elevation changes along pipes do not affect the steady or 
transient behavior of the system. Exceptions are high points which 
cavitate. If desired, AFT Impulse can model varying elevations along a 
pipe. 

Fitting library 

AFT Impulse offers a library of about 400 fitting losses which can be 
added to pipes. 

 



Chapter 7   Other AFT Impulse Capabilities   131 

Design alerts

Design Alerts can be entered for pipes and then cross-plotted vs. system 
behavior. A common use is maximum and minimum allowed operating 
pressure. These can be entered as Design Alert for pipes and then plotted 
against predicted pressure transients.  

Network databases

Junction components and pipe materials can be saved to databases for 
later reuse. Databases can be located on local PC's or deployed across 
local or wide area networks. The Database Manager allows users to 
connect to relevant databases for their specific pipe system design. 
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